# Table of Contents

## Preface
- Objectives of this Book ............................................................................. 5
- Organization ................................................................................................. 5
- Conventions ................................................................................................. 6

## Chapter 1 Installing the ShoreTel Connect Client
- Overview ........................................................................................................ 8
- Installing the ShoreTel Connect Client on Windows OS ......................... 9
- Installing the ShoreTel Connect Client on OS X ................................... 9

## Chapter 2 Using the ShoreTel Connect Client
- Signing in to the ShoreTel Connect Client ............................................. 12
- Changing the ShoreTel Connect Client Password .................................. 12
- Navigating through the ShoreTel Connect Client Interface ................. 13
  - Pinning Tabs for Quick Access ............................................................... 15
  - Docking the Connect Client ................................................................. 16
- Adding Shortcuts to the Client Toolbar .................................................. 16
- Selecting Preferred Language .................................................................. 17
- Setting a Sound Notification .................................................................... 17
- ShoreTel Connect Client Logs ................................................................. 18
- Sharing Data with ShoreTel ....................................................................... 19

## Chapter 3 Managing Contacts
- Managing Contacts .................................................................................... 22
  - Adding a Contact on Mac OS ................................................................. 23
  - Adding a Contact on Windows ............................................................... 23
  - Viewing Information of a Contact ......................................................... 24
  - Importing the Contact Folders .............................................................. 25
  - Deleting a Contact .................................................................................. 25
  - Adding a Contact to your Favorites List ............................................... 26
  - Viewing Favorites ................................................................................... 26
  - Searching Contacts ................................................................................ 26
  - Sorting Contacts ...................................................................................... 26
  - Viewing Call Stack Information of a Contact ...................................... 27
- Managing Contact Groups ......................................................................... 27
### Table of Contents

- Replying to a Voicemail Message .................................................. 57
- Forwarding a Voicemail Message .................................................. 57
- Deleting a Voicemail Message ....................................................... 58
- Restoring a Deleted Voicemail Message ......................................... 58
- Configuring Email Notifications for Voicemail Messages ................. 58
- Setting Popup Notifications for Voicemail Messages ....................... 58
- Changing your Voicemail Password .............................................. 59
- Recording Voicemail Greeting Name ............................................. 59
- Playing Envelope Information for Voicemail ................................... 60
- Routing Calls .................................................................................. 60
- Availability Routing ........................................................................ 60
- Using Power Routing ........................................................................ 65
- Routing Calls to Mobile ................................................................... 67
- Customizing your Call Option Settings ............................................ 67

**Chapter 7** Managing Instant Messaging ........................................ 69
- Sending an Instant Message ............................................................ 70
- Viewing IM Conversation History with a Contact ......................... 71
- Scheduling a Meeting with a Contact Group ................................... 71
- Sending a Group Voicemail ............................................................. 72
- Managing Instant Messaging Notifications ..................................... 72
- Adding Canned IM Responses ....................................................... 73
- Blocking IM Notifications for Specific Users ................................... 73

**Chapter 8** Integrating with Microsoft Exchange .............................. 75
- Integrating the ShoreTel Connect Client with Microsoft Exchange ...... 76
  - Synchronizing the Events and the Availability Status with Microsoft Outlook or Office 365 Calendar ......................................................... 77
  - Synchronizing the Connect Client with Microsoft Outlook or Office 365 Contact Folders ................................................................. 78
  - Synchronizing the Connect Client Voicemails with Microsoft Outlook or Office 365 ................................................................. 79

**Chapter 9** Managing Conferences .................................................. 81
- Creating a Conference ..................................................................... 82
  - Creating a Conference from Microsoft Outlook ............................. 84
  - Creating a Reservation-less Conference from My Conference Bridge ................................................................................................. 85
  - Migrating Reservation-less Conferences from ShoreTel Communicator ................................................................................................. 86
- Viewing Conferences ....................................................................... 86
- Downloading the iCalendar Data (ICS) File for a Conference ........... 87
- Joining a Conference ....................................................................... 87
  - Joining a Conference from the Notification Area ........................... 88
  - Joining a Conference from the Events Tab ..................................... 89
  - Joining a Conference from Your Calendar .................................... 90
- Placing a Participant on Mute .......................................................... 90
- Dropping a Participant from Conference .......................................... 91
- Recording a Conference .................................................................. 91
- Canceling a Conference ................................................................... 92
  - Canceling a Conference from the Connect Client ........................ 92
  - Canceling a Conference from Microsoft Outlook ........................... 92
| Chapter 10 | Sharing on the ShoreTel Connect Client | 99 |
| Chapter 11 | Managing Workgroups | 101 |
| Appendix A | Operator Features | 109 |

**Chapter 10**
Sharing on the ShoreTel Connect Client

- Sharing Screens with a Contact

**Chapter 11**
Managing Workgroups

- Workgroups Overview
- Workgroups Access Types
- Identify Call by Workgroup Name
- Managing Workgroups
- Viewing Workgroups Information
- Assigning Call Handling Mode Status
- Filtering Queued Calls
- Managing Agents
- Accessing Workgroups Voicemails
- Configuring Workgroup Notifications
- Setting Queue Monitor Alert Threshold

**Appendix A**
Operator Features

- Operator Features
Preface

This preface provides information about the objectives, organization, and conventions used in the User Guide.

Objectives of this Book

This guide explains how to install, configure, administer, and maintain the ShoreTel Connect client.

Organization

This guide includes the following sections:

Table 1: User Guide Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, Installing the ShoreTel Connect Client</td>
<td>Describes the requirements and procedures to install and launch the ShoreTel Connect client on Windows and Macintosh.</td>
</tr>
<tr>
<td>Chapter 2, Using the ShoreTel Connect Client</td>
<td>Describes the procedure to sign in and navigate through the ShoreTel Connect client.</td>
</tr>
</tbody>
</table>
| Chapter 3, Managing Contacts | Describes the procedures to:  
  - Add and delete a contact  
  - Create, edit, and delete a contact group |
| Chapter 4, Managing Availability States | Describes the availability icons and the process to change the availability status. |
| Chapter 5, Managing Phones | Describes the procedures to assign a desk phone, softphone, and external number to the ShoreTel Connect client. |
| Chapter 6, Managing Calls | Describes the procedures to manage and route the calls and voicemails. |
Table 1: User Guide Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Chapter 7, Managing Instant Messaging | Describes the procedures to:  
- Send an Instant Message (IM) and group voicemail  
- Manage the IM notifications |
| Chapter 8, Integrating with Microsoft Exchange | Describes the procedure to:  
- Integrate the ShoreTel Connect client and voicemail with Microsoft Exchange  
- Integrate the Outlook contacts and calendar with the ShoreTel Connect client |
| Chapter 9, Managing Conferences | Describes the procedures to:  
- Create, view, record, and cancel conferences.  
- Join a ShoreTel Conference from any non-ShoreTel network without entering any authentication details. |
| Chapter 10, Sharing on the ShoreTel Connect Client | Describes the procedure to share screens and files on the ShoreTel Connect Client. |
| Chapter 11, Managing Workgroups | Describes the procedure to view workgroup information, filter queued calls, manage agents, and share voicemail. |
| Appendix A, Operator Features | Describes the features available only for Operators. |

Conventions

This guide uses the following advisory notices:

- **Note**: This information is extra, or supplementary.

The following typographical marking conventions are used in this document:

<table>
<thead>
<tr>
<th>Marking</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Names of interface objects, such as buttons and menus.</td>
</tr>
</tbody>
</table>
| **Blue** | Cross references with hyper-links. Click the blue text to go to the indicated section.  
**Note**: Table of Contents entries are also links, but they are not shown in blue. |
CHAPTER 1

Installing the ShoreTel Connect Client

This chapter provides information about how to install the ShoreTel Connect client.

Overview ..................................................................................................................... 8
Installing the ShoreTel Connect Client on Windows OS ............................................. 9
Installing the ShoreTel Connect Client on OS X.......................................................... 9
Overview

The ShoreTel Connect client presents a single interface to manage business communications using a ShoreTel desk phone, computer, or mobile phone. With support for Microsoft Windows, Macintosh (OS X), and Collaboration for Web, the ShoreTel Connect client simplifies your day-to-day communications and streamlines your work.

Operating System

For Microsoft Windows:

- Microsoft Windows 7 SP1
- Microsoft Windows 8
- Microsoft Windows 8.1
- Microsoft Windows 10

For Macintosh OS X:

- Apple OS X 10.11
- Apple OS X 10.12

For Windows Server:

- Windows Server 2012, 64-bit (Standard)
- Windows Server 2008 SP2 (Standard)

Supported Servers

- Microsoft Exchange 2010
- Microsoft Exchange 2013
- Microsoft Exchange 2016
- Microsoft Office 365

Supported Browsers

For Microsoft Windows:

- Chrome 55.0 and above
- Internet Explorer 11
- Firefox 49.0 and above
- Edge 38

For Macintosh OS X:

- Chrome 55.0 and above
- Firefox 49.0 and above
- Safari 9.0 and above
Supported Environments
- Citrix XenDesktop 7.6 LTSR
- Citrix XenApp 7.6 LTSR

Installing the ShoreTel Connect Client on Windows OS

1. Do one of the following:
   - Open the e-mail notification from your ShoreTel administrator that describes how to install the ShoreTel Connect client, and click the link to install the client.
   - In a browser, enter \<FQDN>/shorewareResources/ClientInstall, where FQDN is your company's fully qualified domain name, click the ShoreTel Connect client, and click Next.

2. On the License Agreement page, select I accept the terms in the license agreement, and click Next.

3. Click Next to install the client in the default folder, or click Change to change the destination folder and continue.

4. On the Ready to Install the Program page, click Install.

5. On the InstallShield Wizard page, click Finish.

6. On the Start menu, click the ShoreTel Connect icon to launch the client.

Installing the ShoreTel Connect Client on OS X

1. Do one of the following:
   - Open the e-mail notification from your ShoreTel administrator that describes how to install the ShoreTel Connect client, and click the link to install the client.
   - In a browser, enter \<FQDN>/shorewareResources/ClientInstall, where FQDN is your company's fully qualified domain name, and click the ShoreTel Connect client.

   The installation file is downloaded to the default downloads folder on your computer.

2. Double-click the installation file.
3. In the ShoreTel Connect screen, drag the **ShoreTel Connect** icon into the **Applications** folder and double-click the icon to launch the client.
CHAPTER 2

Using the ShoreTel Connect Client

This chapter provides information about how to use the ShoreTel Connect client.

- Signing in to the ShoreTel Connect Client .......................................................... 12
- Changing the ShoreTel Connect Client Password .............................................. 12
- Navigating through the ShoreTel Connect Client Interface ................................ 13
- Pinning Tabs for Quick Access ........................................................................... 15
- Docking the Connect Client ................................................................................ 16
- Adding Shortcuts to the Client Toolbar ............................................................... 16
- Selecting Preferred Language .............................................................................. 17
- Setting a Sound Notification ............................................................................... 17
- ShoreTel Connect Client Logs ............................................................................ 18
- Sharing Data with ShoreTel ............................................................................... 19
Signing in to the ShoreTel Connect Client

You can sign in to the Connect client using the ShoreTel Connect credentials.

1. Double-click the ShoreTel Connect client icon and enter your ShoreTel Connect credentials:
   - Email address or username
     If your Connect client and Microsoft Exchange email addresses are the same, sign in using your email address to integrate the Connect client with Microsoft Exchange. For more details about integrating the Connect client with Microsoft Exchange, refer to Chapter 8, Integrating with Microsoft Exchange on page 75.
   - Password

2. If desired, select any of the following optional settings:
   - If you are signing in using the Windows credentials, select the Use Windows Credentials check box to fetch your credentials.

   ![Note]
   The Use Windows Credentials option is applicable only for ONSITE users.

   - To save your credentials, select the Remember this and log me in automatically next time check box.

3. Click +Show Advanced... to see the Domain and Server fields.

4. In the Server field, enter the fully qualified domain name (FQDN).

5. Click Log In.

To Sign out from the ShoreTel Connect client, click the <username> tab, and click Log Out.

![Note]
Depending on how your system is configured, you might need to enter your credentials manually rather than using the Use Windows Credentials check box.

Changing the ShoreTel Connect Client Password

1. On the dashboard, click the <username> tab.

2. For Mac OS, click Preferences.
   For Windows, click Settings.

3. Click Account > Login.
4. Enter:
   - Current password
   - New password
   - Confirm new password

5. Click **Set New Password**.

**Navigating through the ShoreTel Connect Client Interface**

The ShoreTel Connect client consists of three panes based on the options you select on the dashboard, as shown in **Figure 1**.

- **Connect menu bar**—Use the **Connect** drop-down on the client menu bar to do the following:
  - View information about the ShoreTel Connect.
  - Check for updates.
  - Open the Settings page (for Windows) or Preferences page (for Mac OS).
  - Show or edit the toolbar.
  - Set the Connect client to be on top while navigating through other applications. For Mac OS, this option is available in the **Window** tab on the Mac menu bar.
Access the user guide and training videos. For Mac OS, this option is available in the Help tab on the Mac menu bar.

Send log files to the ShoreTel Support. For Mac OS, this option is available in the Help tab on the Mac menu bar.

Exit the Connect client.

**Dial Pad**—Use the dial pad to dial a phone number.

**Quick Dialer Search Bar**—Use the quick dialer search bar to search for a name, number, an email address, or company name.

**Dashboard**—Dashboard is the default and the main navigation pane:

- **<username>**—Click the <username> tab to view or edit your profile information. You can add your LinkedIn profile picture as your Connect client profile picture. If the Connect client is integrated with Microsoft Exchange, it imports your Outlook profile picture. For more information about integrating with Microsoft Exchange, refer to Chapter 8, Integrating with Microsoft Exchange on page 75.

- **People**—Use the People tab to view your contacts, add a new contact, create groups, and add contacts to Favorites or Groups.

- **Recent**—Click the Recent tab to view previous calls and missed calls.

- **Voicemails**—Click the Voicemails tab to view your new, flagged, and deleted voicemails. The badge on the Voicemails tab indicates the number of unheard voicemail messages.

- **Messages**—Click the Messages tab to view your chat logs. Click any chat from the logs to open the conversation details in the third pane. The badge on the Messages tab indicates the number of unread messages.

- **Events**—Click the Events tab to view your past and upcoming calendar appointments. To view your Outlook appointments, synchronize your Connect client with Microsoft Exchange.

- **Workgroups**—Click the Workgroups tab to view active workgroup calls for a user and the current workgroup state of the user. To view information about workgroups, you must be a member of a workgroup and have the appropriate license type.

---

**Note**

The Workgroup feature is available only for Connect ONSITE users.
You can expand or collapse the dashboard view by clicking the up/down arrow icon. In collapsed view, you can mouse hover on each icon to view the tool tip.

Figure 2: Dashboard Collapsed View

- **Notification**—The Notification area shows incoming calls, voicemail messages, events, or error messages.

- **Interaction Area**—The Interaction area shows the list of all conversations.

- **Secure Connection**—This icon indicates that the connection to the Connect server is secure.

- **Second Pane**—The second pane displays information based on what you select on the dashboard.

- **Third Pane**—The third pane displays information based on what you select on the second pane. For example, if you click a contact on the second pane, the third pane displays the contact card, the conversation history, and the IM input field for interacting with the selected contact.

  - **Contact Card**—View the details of the selected contact.
  
  - **Conversation History**—View the history for the selected contact.
  
  - **IM Input Field**—Type your instant messages to the selected contact.

Click the minimize button at the top-right corner of a pane to close the pane.

### Pinning Tabs for Quick Access

You can pin a tab to the dashboard for quick access. The pinned tab remains open in the second pane with the dashboard. While navigating through the other tabs, you can view the pinned tab in the second pane after you close the open tabs. You can pin only one tab to the dashboard.

To pin a tab to the dashboard:

1. On the dashboard, select the tab.

2. Click ✨ icon.

To unpin the tab, click ✨ icon.
Docking the Connect Client

You can dock the Connect client to keep it always on top when navigating through other applications.

For Windows:
1. On the client menu bar, click the **Connect** drop-down.
2. Select **Always On Top**.

For Mac OS:
1. On the Mac menu bar, click **Window**.
2. Select **Always On Top**.

Adding Shortcuts to the Client Toolbar

**Note**
This feature is available only for ONSITE users.

From the client toolbar, you can add shortcuts for your most used or preferred operations. The configured buttons function as shortcuts to access operations that require more actions to accomplish the same task. You can use these shortcut buttons to perform a one-click operation for monitoring a call, starting a voice recording, opening the agent queue monitor, activating the softphone, or any other option defined by your organization.

To enable this feature, your administrator must first configure the Client Toolbars programmable buttons in ShoreTel Connect Director for each user.

The list of configured shortcuts is displayed in a client window. To view or hide the client toolbar from the ShoreTel Connect client, click the **Connect** drop-down on the client menu bar and toggle **Show Toolbar**.

To select which shortcut buttons are displayed in your client toolbar:
1. Click the **+** icon at the bottom right of the toolbar panel.
2. Select the buttons to add to the toolbar panel.

**Note**
You can add up to 140 buttons to the client toolbar.

You can drag and drop to re-order the buttons. The keyboard shortcuts to the first 10 buttons are auto-assigned based on your order on the client toolbar. For MAC OS, use CMD+0-CMD+9, and for Windows, use ALT+0-ALT+9 as keyboard shortcuts. You can hover the mouse over the buttons to view the tool tip. For a Monitor Extension button, you can also view the availability state of the extension that you are monitoring.
Selecting Preferred Language

You can select the language for your deskphone and the ShoreTel Connect client interface.

1. On the dashboard, click the `<username>` tab.

2. For Mac OS, click Preferences and then click Language.
   
   For Windows, click Settings and then click Language.

3. From the Deskphone & voicemail menus drop-down list, select the desired language for your desk phone.

4. From the I want to use this application in drop-down list, select the required language for the ShoreTel Connect client interface.

   You must exit and restart the client for the change to take effect.

Setting a Sound Notification

You can create a sound notification to identify a specific event, such as a voicemail, a call from an internal or external number, a monitored call, a shared call, or to identify a new or an existing conversation.

1. On the dashboard, click the `<username>` tab.

2. For Mac OS, click Preferences.
   
   For Windows, click Settings.

3. Click Notifications > Sounds.

4. In the Audio Alerts field, select ON.
5. In the **For event** field, click the drop-down list on the right, and select any of the following:

- new voicemail
- call from an internal number
- call from an external number
- new IM message initiating a new conversation
- new IM message initiating an existing conversation
- monitored call
- shared line call

6. Select **Play alert**, click the drop-down list on the right, and select a required sound from the list.

---

**Note**

Other than the default list of sounds, you can also add or remove a new .wav file.

---

**ShoreTel Connect Client Logs**

The ShoreTel Connect client creates a log file each time you log in. The logs are used to help ShoreTel Technical Support with debugging problems that may arise during the client operation. You can send the log files to your ShoreTel Administrator while opening a troubleshooting ticket.

To send the client log files:

- **For Windows:**
  1. On the Connect Menu Bar, click the **Connect** drop-down list.
  2. Select **Send Client Logs** and follow the on-screen instructions.

- **For Mac OS:**
  1. On the Mac menu bar, click the **Help** tab.
  2. Select **Send Client Logs** and follow the on-screen instructions.
Sharing Data with ShoreTel

The Connect client sends the user interaction data anonymously to ShoreTel by default. The data is analyzed by ShoreTel support for enhancing the Connect client application.

**Note**

All anonymous data is encrypted and cannot be traced back to the user.

To disable sending user interaction data to ShoreTel:

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click Preferences.
   
   For Windows, click Settings.
3. Click Account > Access.
4. Clear the Yes, I want to help ShoreTel build better products! Send anonymous data to ShoreTel check box.

You must exit and restart the Connect client for the change to take effect.
Managing Contacts

This chapter provides information on how to manage your contacts.

Managing Contacts ................................................................. 22
  Adding a Contact on Mac OS .................................................. 23
  Adding a Contact on Windows.................................................. 23
  Viewing Information of a Contact ............................................ 24
  Importing the Contact Folders ............................................... 25
  Deleting a Contact ............................................................... 25
  Adding a Contact to your Favorites List ................................. 26
  Viewing Favorites ............................................................... 26
  Searching Contacts ............................................................. 26
  Sorting Contacts ............................................................... 26
  Viewing Call Stack Information of a Contact ......................... 27
Managing Contact Groups ..................................................... 27
  Creating a Contact Group .................................................... 27
  Reordering the List of Contact Groups ................................. 28
  Editing or Deleting a Contact Group ...................................... 28
Managing Contacts

The ShoreTel Connect client enables you to organize and manage your contacts.

To view the system directory that shows all the contacts in your organization, click in the **Quick Dialer Search** bar. The contact names with special characters and numbers are displayed first, and followed by names in the alphabetical order by the last name with alpha headers.

To find a contact, type any of the following in the **Quick Dialer Search** bar:

- First Name
- Last Name
- Email address
- Company name
- Extension number
- Double token (single letter and double letter of the contact’s name). For example, you can type P R or Pa Ro to search for Patrick Roberts.

*Figure 3* describes the process of adding a contact and viewing the contact’s information.

![Figure 3: Managing Contacts](image-url)
Adding a Contact on Mac OS

1. Do one of the following:
   - Click the **Recent** tab, right-click the contact, and select **Add as a Contact**.
   - Click the **People** tab, and click **New Contact** at the bottom left corner of the second pane.
   
   The address book contact form is displayed.

   **Note**
   
   The address book opens only if you have enabled the ShoreTel Connect client in the System Preferences on your Mac.

2. Type the contact details in the required fields.
3. Click **Done**.

Adding a Contact on Windows

You can add a new contact using the Microsoft Outlook contact form and the Connect client contact form.

To add contact using the Microsoft Outlook contact form:

1. Do one of the following:
   - Click the **Recent** tab, right-click the contact, and select **Add as a Contact**.
   - Click the **People** tab, and click **New Contact** at the bottom left corner of the second pane.

   An Untitled Outlook Contact form is displayed.

2. Type the contact details in the required fields.
3. Click **Save & Close**.

**Note**

You can add a new contact through Outlook contact form only if:

- Your ShoreTel Connect administrator has configured the Microsoft Exchange account on the Connect Director.
- Microsoft Outlook is installed on your computer.

1. Do one of the following:
   - Click the **Recent** tab, right-click the contact, and select **Add as a Contact**.
   - Click the **People** tab, and click **New Contact** at the bottom left corner of the second pane.

   An Untitled Outlook Contact form is displayed.

2. Type the contact details in the required fields.
3. Click **Save & Close**.

**Note**

If you have installed the Microsoft Outlook on your computer, the Outlook contact form opens by default when adding a new contact. However, you can set the Connect client to open the Connect contact form instead of Outlook contact form.
To open the Connect contact form instead of Outlook contact form when adding a contact:

1. On the dashboard, click the `<username>` tab.
2. Click Settings and click Outlook.
3. Select the Do not open Outlook when adding contact to Connect option.

To add a new contact using the Connect contact form:

1. Do one of the following:
   - Click the Recent tab, right-click the contact, and select Add as a Contact.
   - Click the People tab, and click New Contact at the bottom left corner of the second pane.

   The Contact form opens in the third pane.
2. Type the contact details in the required fields.
3. Click Add Contact.

Viewing Information of a Contact

1. In the Quick Dialer Search bar, type the contact name or extension number and select the contact.

   The Contact card opens in the third pane.

2. In the Contact card, click + Info to view the contact's details and click - Hide Info to hide the contact's details.

To see the company name, department name, and phone number of a contact from the Quick Dialer Search bar, Favorites or Groups tab:

1. Right-click the contact in the second pane.
2. Select the Show Company Name, Show Department Name, and Show Phone Number options to view or hide the contact information.

   The phone numbers of the contact are displayed in the order; Extension (.extend), Business or Work (extension), Mobile (mobile), and Home (home). If a contact has configured all the four phone numbers on the Connect client, by default, the first two phone numbers in the order get displayed in the second pane.

   To view all the phone numbers, click More. The Contact card opens in the third pane with + Info expanded where all the phone numbers of the contact are displayed.

**Note**

The More option is displayed only if the contact has configured more than two phone numbers.
Importing the Contact Folders

For Mac OS, you can import the contact folders from the Mac address book into the Connect client. If the Microsoft Outlook is installed on your computer, the Mac address book synchronizes with the Microsoft Outlook or Office 365 contact folders.

To import the contact folders from the Mac address book:

1. On the dashboard, click the `<username>` tab.
2. Click Preferences.
3. Click Contacts/Outlook.
4. Select Sync my Mac Contacts option.
5. Click +Show contact folders and select the folders that you want to import into the Connect Client.

For Windows, if you have integrated the Connect client with Microsoft Exchange, you can import the contact folders from Microsoft Outlook or Office 365 into the Connect client. For information about importing the contact folders from Microsoft Outlook or Office 365 into the Connect client, refer to Synchronizing the Connect Client with Microsoft Outlook or Office 365 Contact Folders on page 78.

Deleting a Contact

If your Connect client is integrated with your Microsoft Outlook, you can delete all the contacts imported from the Outlook at once using the Connect client interface. However, you cannot delete an individual contact from the Connect client interface, but you can delete from Outlook.

To delete all the contacts imported from Outlook:

1. On the dashboard, click `<username>` tab.
2. For Mac OS, click Preferences.
   
   For Windows, click Settings.
3. Click Outlook.
4. Click Remove Synced Contacts option.
5. In the confirmation dialog box, click Remove.

   All your contacts imported from Outlook are deleted at once. The Remove Synced Contacts option is disabled and the Sync my Outlook contacts option is cleared.
If Microsoft Outlook is not integrated with the Connect client, you can delete a contact by:

1. In the Quick Dialer Search bar, type the contact name or extension.
2. Click the name of the contact that you want to delete.
3. Click + Info below the profile picture.
4. Click Delete Contact.
5. In the confirmation dialog box, click Delete.

---

**Note**

You can delete only the external contacts that you have added to the Connect client. However, you cannot delete contacts available through the system directory of your organization.

---

### Adding a Contact to your Favorites List

1. In the Quick Dialer Search bar, type the contact name or extension.
2. Click the Star icon next to the contact name that you want to mark as a favorite.
3. To remove the contact from the favorites list, click the Star icon next to the contact name again.

### Viewing Favorites

1. Click the People tab on the dashboard.
2. Click the Favorites tab in the second pane to view the list of contacts marked as favorites.

### Searching Contacts

You can search the contacts added to your Favorites or Group. To search a contact, enter the contact’s name, or extension in the Search field in the Favorites or Group tab.

For more details about viewing information of a contact, refer to Viewing Information of a Contact on page 24.

### Sorting Contacts

You can select how your contacts are sorted and displayed in favorite and group list. You can sort the contacts by last name, first name, availability, and last contact in your favorite and group list. You can also use My Order option in a group to view contacts in the order you have re-arranged them.
To sort your contacts in favorite:

1. Click **People > Favorites**.
2. Right-click the contact, and select the desired **Sort** option.

To sort your contacts in group:

1. Click **People > Groups**.
2. Right-click the contact in group, and select the desired **Sort** option.

### Viewing Call Stack Information of a Contact

You can view the availability state and call stack information of a contact if the contact is added to your Favorites or Groups list.

To view the call stack information, do one of the following:

- Click **People > Favorites** or **Groups**. Hover on a contact to view the tool tip.
  
  Tool tip displays the contact’s availability state and call stack information.

- Open the contact card and click $i$ next to the contact name to view the contact’s availability state and call stack information.

### Managing Contact Groups

#### Creating a Contact Group

1. On the dashboard, click the **People** tab.
2. Click the **Groups** tab, and click **New Group** at the bottom left of the second pane.
3. In the **Group Name** field, type a group name.
4. In the **Members** field, do one of the following:
   
   - Start typing a contact name. When the desired name appears, select it.
   - Click the **Quick Dialer Search** bar, and drag and drop the contacts from the search results.
5. Click **Save Changes** to save the group.
Reordering the List of Contact Groups

1. Click the People tab on the dashboard.
2. Click the Groups tab to view all the groups created.
3. Click the group header and drag and drop to the required position.

Any changes to the order of groups is persistent between the client restarts.

Editing or Deleting a Contact Group

1. Click the People > Groups tabs on the dashboard.
2. Click the header of the contact group that you want to edit or delete.
3. Click Edit Group.
4. Do one of the following:
   - To add a contact, click in the Members field and start typing the contact's name. When the desired name appears, select it. Repeat as needed, and then click Save Changes.
   - To remove a contact, click the x to delete the contact from the group, and then click Save Changes.

Tip

Type the contact name or number in the Quick Dialer Search bar, and right-click the contact on the second pane, and select Add to Group to add the contact to the required group.

- To reorder the contact names, select a contact, drag and drop the selected contact to the desired place, and click Save Changes.
CHAPTER 4

Managing Availability States

This chapter provides information about managing availability states for users and their contacts.

Understanding Availability States ................................................................. 30
Setting Alert for Contact’s Availability State ................................................. 31
Changing Availability State ........................................................................... 31
Selecting a Predefined Availability State ....................................................... 32
Configuring a Custom Availability State ......................................................... 32
Allowing a Contact to Manage your Availability State ................................. 32
Understanding Availability States

You can check or verify the availability status of a contact on the ShoreTel Connect client before communicating with the contact. The ShoreTel Connect client automatically updates the availability status of users as they make and receive calls. When integrated with Microsoft Exchange, the ShoreTel Connect client also displays users’ meeting status.

You can monitor the availability of up to 500 contacts, and this can be configured by your ShoreTel Connect administrator.

The different availability states are described in **Table 2**.

<table>
<thead>
<tr>
<th>Color</th>
<th>State</th>
<th>Predefined/Customizable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Available</td>
<td>Predefined</td>
<td>The contact is available for a call or IM session.</td>
</tr>
<tr>
<td>Yellow</td>
<td>In a Meeting</td>
<td>Predefined</td>
<td>The contact is in a meeting, but you can still reach the contact through an IM session. If you dial this contact, the call will be routed...</td>
</tr>
<tr>
<td>Red</td>
<td>Out of Office</td>
<td>Predefined</td>
<td>If you dial this contact, the call will be routed to the contact’s voicemail inbox or to the number configured using the availability routing...</td>
</tr>
<tr>
<td>Red</td>
<td>Do not Disturb</td>
<td>Predefined</td>
<td>The contact is busy and does not wish to be reached. However, you can reach this contact through an IM. If you dial this contact, the call will be...</td>
</tr>
<tr>
<td>Red</td>
<td>Vacation</td>
<td>Predefined</td>
<td>If you dial this contact, the call will be routed to the contact’s voicemail inbox or to the number configured using the availability routing...</td>
</tr>
<tr>
<td>Gray</td>
<td>Custom</td>
<td>Customizable</td>
<td>The contact has a custom status, depending on the configured option. If you dial this contact, the call will be routed to the contact’s voicemail inbox or...</td>
</tr>
</tbody>
</table>
Setting Alert for Contact’s Availability State

If you want to communicate with a contact who is currently not in Available state, you can set the Connect client to notify you when the contact’s status changes to Available.

To receive a notification:

1. In Quick Dialer Search bar, type the contact name or extension, and select the contact.

2. In Contact Card, click the drop-down list on the top-right corner and select Alert When Available.

Also, if the contact is added to your Favorites or Groups list, right-click the contact in Favorites or Groups tabs, and select Alert When Available.

You can set the alert only for the contacts available through the system directory of your organization. However, you cannot set this alert for any external contacts that you have added to the Connect client.

**Note**

Alerts are disabled when the Connect client restarts.

Changing Availability State

The ShoreTel Connect client automatically updates your availability state when you use the system, but you can select a predefined availability state or configure a custom availability state.
Selecting a Predefined Availability State

1. From the dashboard, click the drop-down menu to the left of the <username> tab.
2. Select one of the following availability states:
   - Available
   - In a Meeting
   - Out of Office
   - Do not Disturb
   - Vacation

Configuring a Custom Availability State

1. From the dashboard, click the drop-down menu to the left of the <username> tab.
2. Click the Custom availability state and click the color in the list.
   - Available (Green)
   - Busy (Yellow)
   - Not Available (Red)
3. Enter your custom status in the Type a status field, and press Enter.

The custom availability status and color is displayed on the <username> tab.

Note
The color of the availability state cannot be customized.

Allowing a Contact to Manage your Availability State

You can configure a contact to manage your availability state on the ShoreTel Connect client.

To manage your availability state, the contact must meet the following requirements:

- The contact must have added you to a contact group.
The contact must have a Workgroup Supervisor or Operator license type and be configured with a specific class of service in ShoreTel Connect Director.

**Note**
The Workgroup feature is available only for Connect ONSITE users.

To allow access to a contact to manage your availability states:

1. On the dashboard, click the `<username>` tab.
2. For MAC OS, click **Preferences**.
   
   For Windows, click **Settings**.
3. Click **Account > Access**.
4. Type in the contact name for whom you want to allow access, and close the page. The contact is configured to change your availability state until you revoke access by removing the contact from the **Access** page.
Managing Phones

This chapter provides information about managing your desk phone, softphone, and external phones.

Managing your Desk Phone ................................................................. 36
Assigning your Desk Phone ................................................................. 36
Customizing your Desk Phone .............................................................. 36
Removing the Desk Phone Assignment .................................................. 36
Using the Softphone ............................................................................. 37
Assigning Softphone ........................................................................... 37
Customizing the Softphone ................................................................. 38
Assigning External Phones .................................................................. 38
Managing your Desk Phone

This section provides information about assigning a desk phone to your ShoreTel Connect client.

Assigning your Desk Phone

1. On the desk phone, press the Assign soft key.
2. In the Extension field, enter your assigned extension number, and press Next or the down key.
3. In the Voicemail password field, enter your voicemail password, and press OK or the # key.
4. Verify the desk phone status in the Connect client as follows:
   a. Launch the ShoreTel Connect client.
   b. Verify the status on the dashboard:
      ■ If the <username> tab displays the status as Assigned Deskphone, then the desk phone is successfully assigned.
      ■ If the <username> tab displays the status as No Deskphone, then repeat steps 1 to 3.
   c. Verify the desk phone status on the second pane:
      ■ Click the <username> tab to display the second pane.
      ■ Click the Primary Assignment tab, and verify that the deskphone option is displayed.

Customizing your Desk Phone

1. On the dashboard, click the <username> tab.
2. For MAC OS, click Preferences.
   For Windows, click Settings.
3. Click the Deskphone tab to display the desk phone options.
   ■ In the Wallpaper field, in the drop-down list, select the preferred wallpaper.
   ■ In the Ringtone field, in the drop-down list, select the preferred ringtone.

Removing the Desk Phone Assignment

1. On the dashboard, click the <username> tab.
2. Click the Primary Assignment tab.
3. To reset the current extension assignment, click Go Back To My Desk Phone.
The deskphone option is removed from the **Primary Assignment** tab. The corresponding extension number is also unassigned from the desk phone.

## Using the Softphone

When you select softphone as your primary assignment, incoming calls are routed to the ShoreTel Connect client. The desk phone functionality is disabled until you assign your desk phone again to the ShoreTel Connect client.

### Assigning Softphone

1. On the dashboard, click the `<username>` tab.
2. For MAC OS, click **Preferences**. For Windows, click **Settings**.
3. Click the **Primary Assignment** tab, and select **softphone**.
   
   If the Softphone option is not displayed, contact your ShoreTel Connect administrator.
4. Select one of the following from the drop-down list:

   - **Default**
   - **Internal Microphone**
   - **Headset Microphone (Plantronics Device)**

   The Plantronics device option is shown in the drop-down list only after you plug in the Plantronics headset to your computer.

   After the softphone is successfully assigned, the `<username>` tab on your dashboard displays **Softphone** next to the status.

### Note

If you are a Connect CLOUD user, then you must have a DID number assigned to your account to use the Softphone feature in the ShoreTel Connect client.
Customizing the Softphone

1. On the dashboard, click the `<username>` tab.
2. For MAC OS, click Preferences.
   
   For Windows, click Settings.
3. Click the Softphone tab to display the softphone options.
   
   If you do not see the Softphone tab, contact your ShoreTel administrator.
4. To switch to a different audio device, in the Capture audio through field, click the drop-down list, and select the preferred audio device.
   
   If required, plug your audio device into the computer’s headset port or use the computer’s built-in speakers.
5. Select On startup assign me to my softphone to handle calls and voicemails on the softphone from the time you first log in to the client.
6. Select Enable auto gain control to enable the automatic control.

Assigning External Phones

1. On the dashboard, click the `<username>` tab.
2. Click the Primary Assignment tab.
3. Click the Select Number drop-down list.
   
   If you do not see the Select Number option, contact your ShoreTel administrator.
4. Type a name in the Label field (for example, Home or Mobile).
5. Enter the associated phone number in the Number field.
   
   You cannot use a phone number that is assigned to ShoreTel Connect for iOS or Android.
6. To choose a method to connect to the external number, click the drop-down list and select one of the following options:
   
   - Automatically connect
   - Press 1 to connect
7. In the **rings to try** field, increase the number of rings to 6 or more to the external phone number before forwarding the call to your voicemail.

**Note**

In **Call Routing** settings, you must set the **rings before incoming calls are routed to the voice mail** option to the number of rings that you set in the **rings to try** field. (Follow the steps 10 to 14 to set the number of rings in Call Routing.)

8. Select a number that you have defined as an external number.

9. Click **Use Selected Number** to change your assigned phone to the configured number.

10. Click the `<username>` tab, and then click **Preferences** for MAC OS or **Settings** for Windows.

11. Click **Call Routing > Availability Routing**.

12. Click **Change** next to the **rings before incoming calls are routed to the voice mail** routing option.

13. Select 6 or more rings from the **rings before forwarding** drop-down list.

14. Click **Save**.
CHAPTER 6
Managing Calls

This chapter provides information about making voice calls and using related features in the ShoreTel Connect client.

Making a Voice Call ................................................................................................... 43
Answering a Voice Call ............................................................................................. 44
Managing Incoming Call Notifications ................................................................. 45
Viewing Call Interaction History with a Contact ......................................................... 45
Transferring a Call ..................................................................................................... 45
  Transferring a Call Using the Transfer Option .................................................... 46
  Transferring a Call Using the Consult Option ..................................................... 47
Parking a Call ..................................................................................................... 48
  Transferring a Call Using the Intercom Option ................................................. 49
  Transferring a Call Using the Whisper Option .................................................... 49
Transferring a Call to Voicemail .......................................................................... 50
Making a Conference Call .......................................................................................... 50
  Creating a Blind Conference Call ....................................................................... 51
  Creating a Consultative Conference Call ......................................................... 51
  Creating an Intercom Conference Call ............................................................. 51
Managing Call Notes and Viewing Routing Slips ...................................................... 52
Making a Video Call .................................................................................................. 54
  Setting Up Video Camera Preferences ............................................................ 54
Managing Voicemail .................................................................................................. 55
  Forwarding Calls to your Voicemail Inbox ........................................................ 55
  Leaving a Voicemail Message ............................................................................ 55
  Accessing Voicemail Messages ........................................................................ 56
Viewing Voicemails from a Contact ................................................................. 56
Listening to a New Voicemail Message ........................................................... 56
Flagging a Voicemail Message ........................................................................ 56
Replying to a Voicemail Message .................................................................... 57
Forwarding a Voicemail Message ................................................................. 57
Deleting a Voicemail Message ........................................................................ 58
Restoring a Deleted Voicemail Message ....................................................... 58
Configuring Email Notifications for Voicemail Messages ............................ 58
Setting Popup Notifications for Voicemail Messages ..................................... 58
Changing your Voicemail Password ............................................................. 59
Recording Voicemail Greeting Name ............................................................ 59
Playing Envelope Information for Voicemail ............................................... 60
Routing Calls ................................................................................................. 60
  Availability Routing .................................................................................... 60
  Using Power Routing .................................................................................. 65
  Routing Calls to Mobile ............................................................................... 67
Customizing your Call Option Settings .......................................................... 67
Making a Voice Call

You can make a call from:

- Quick dialer search bar
- Directory
- Recent
- Dial pad

To make a call from the quick dialer search bar or from the system directory:

1. Type the contact details in the quick dialer search bar on the dashboard.
   Enter the first or last name, extension, company name, department name, phone number, or an email address of the person you would like to search for.

2. Do one of the following:
   - Double-click the contact in the second pane.
   - Click the contact, and click \( \text{📞} \) in the third pane.

To make a call from history:

1. Click the **Recent** tab on the dashboard.

2. Do one of the following:
   - Double-click the contact in the second pane.
   - Click the contact, and click \( \text{📞} \) in the third pane.

To make a call from the dial pad:

1. Click \( \text{📞} \) on the dashboard.

2. Enter the extension or the mobile number, and press enter.
Answering a Voice Call

The ShoreTel Connect client displays a system notification for every incoming call. It also displays a call notification on the Connect client dashboard. The call notification identifies the incoming call by:

- Name in the contact list
- Dialed Number Identification Service (DNIS) if available
- Phone number

To answer an incoming call, do one of the following:

- On the system notification, click **Accept** to answer or **Ignore** to send the call directly to voicemail.

**Note**

For users with Extension only license, only Accept button is displayed on the system notification.

- On the dashboard, click ☑️ to answer, and click ☐️ to directly transfer the call to voicemail.

To reject the call and respond through IM, click ✉️ and type the message or select the canned message, and click **Send**. Click ✅ to end the active call.

- To answer a call using the Plantronics headset:

  **Note**

  You must install the Plantronics hub. If you do not install the Plantronics hub or the hub is down, the headset acts as a normal audio device, and you cannot use the headset buttons to perform call functions. To download and install the Plantronics hub software, refer to the Plantronics website.

  - Set your extension to Softphone. (For more information, see Assigning Softphone on page 37.)
  - Press the call answer button on your headset.

    You can use the call control functions available on your headset. For more information, refer to the Plantronics website.

You can place a voice call on hold and resume when required. Move the cursor on the call notification area to view the hold and resume icons. These options are also available on the contact card:

- To hold the call, click 🛑.
- To resume the call, click 📞.
Managing Incoming Call Notifications

1. On the dashboard, click the <username> tab.
2. For MAC OS, click Preferences.
   For Windows, click Settings.
3. Click Notifications > Popup.
4. To enable notifications, select the Show a system notification for an incoming Call check box.
5. In Keep notification on screen for field, select the time from the drop-down list.

Viewing Call Interaction History with a Contact

1. In the Quick Dialer Search bar, type the name or extension number and select the contact.
2. In the third pane, click the drop-down list in the Search field and select Calls.

Your call history with the selected contact is displayed in the third pane. Click each call entry to view the call origin, the call duration, the call routing slip, and to enter a call note.

If you select Everything in the drop-down list, your call history, voicemail history, and instant message conversation history with the contact are displayed in the third pane.

Transferring a Call

The ShoreTel Connect client allows you to do the following kinds of transfer operations or other actions related to transfers:

- Blind Transfer
- Consultative transfer
- Park
- Intercom
- Whisper
- Voicemail
Figure 4 describes the different types of call transfer options; Transfer, Consult, Park, Intercom, Whisper, and Voicemail options.

Transferring a Call Using the Transfer Option

You can use the transfer option to transfer a call to another extension without actually initiating a call to the end destination. The call is blindly transferred to the other user. You can do the blind transfer using the drag and drop option, the contextual menu, and from the call notification area.

Note
You can do the blind transfer either before or after answering a call. To answer a call, see Answering a Voice Call on page 44.

To do a blind transfer using the drag and drop option:

1. In the Quick Dialer Search bar, type the contact name or the extension number.
2. On the dashboard, drag the call from the call notification area and drop it on the contact in the second pane.

To do a blind transfer using the contextual menu:

1. In the Quick Dialer Search bar, type the contact name or the extension number.
2. Drag the call from the call notification area and hover over the contact for two seconds to view the contextual menu. Select **Blind transfer** from the contextual menu to complete the call transfer.

To do a blind transfer from the call notification:

- **Before answering the call:**
  
  a. On the dashboard, click 📞 in the call notification.
  
  b. In the second pane search field, type the contact name or the phone number.
  
  c. Click **Transfer**.

- **After answering the call:**
  
  a. On the dashboard, click 📞 in the call notification.
  
  b. In the second pane, click 📞 .
  
  c. In the second pane search field, type the contact name or phone number.
  
  d. Click **Transfer**.

**Transferring a Call Using the Consult Option**

- **Before answering the call:**
  
  a. On the dashboard, click 📞 in the call notification.
  
  b. In the second pane search field, type the contact name or the phone number.
  
  c. Click **Consult**.

- **After answering the call:**
  
  a. On the dashboard, click 📞 in the call notification.
  
  b. In the second pane, click 📞 .
  
  c. In the second pane search field, type the contact name or phone number.
  
  d. Click **Consult**.
Parking a Call

You can park a call using the contact card or the contextual menu. If the call is not answered at the specified extension, the call is returned to you with the routing slip indicating that you have already spoken to this caller.

To park a call using the contact card:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 44.)

2. In the second pane, click 📞.

3. In the second pane search field, type the contact name or phone number.

4. Click the Park option.

5. Click 📞 to park the call.

To park a call using the contextual menu:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 44.)

2. In the Quick Dialer Search bar, type the contact name or number and select the contact.

3. Drag the active call in the notification area and hover over the selected contact for two seconds to view the contextual menu.

4. Select Park from the contextual menu to complete the call transfer.

 appears next to the contact name indicating that the call is parked on the contact’s call stack.

Park and Page

To park a call and page a contact:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 44.)

2. In the second pane, click 📞.

3. In the second pane search field, type the contact name or phone number.

4. Click the Park option.

5. Click 📞 to park and page the call.
Park and Intercom

You can use the park and intercom option to place an intercom call in which the recipient phone automatically answers with mute activated and broadcasts your message through the recipient’s speaker phone, headset, or handset.

To park and intercom a call:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 44.)
2. In the second pane, click 🔊.
3. In the second pane search field, type the contact name or phone number.
4. Click the Park option.
5. Click 🔄 to park the call and place an intercom call to the selected contact.

Transferring a Call Using the Intercom Option

Before answering the call:

a. On the dashboard, click 📞 in the call notification.

b. In the second pane search field, type the contact name or the phone number.

c. Click Intercom.

After answering the call:

a. On the dashboard, click 📞 in the call notification.

b. In the second pane, click 🔊.

c. In the second pane search field, type the contact name or phone number.

d. Click Intercom.

Transferring a Call Using the Whisper Option

Before answering the call:

a. On the dashboard, click 📞 in the call notification.

b. In the second pane search field, type the contact name or the phone number.

c. Click Whisper.
After answering the call:

a. On the dashboard, click in the call notification.

b. In the second pane, click .

c. In the second pane search field, type the contact name or phone number.

d. Click Whisper.

Transferring a Call to Voicemail

On the dashboard, click in the call notification to transfer the call directly to your voicemail without answering the call.

To transfer the call to another contact’s voicemail:

1. On the dashboard, click in the call notification to answer the call.

2. In the second pane, click .

3. In the second pane search field, type the contact name or phone number.

4. Click Voicemail.

Making a Conference Call

A conference call involves more than two parties connected in a call. The number of people you can conference together in a call depends on your system configuration. Contact your ShoreTel Connect administrator for the details about your system’s conference capabilities.

You can set up a conference call using either of the following approaches:

- In a blind conference call, you conference the people together without the other person first answering your call.

- In a consultative conference call, you talk to the person before adding that person to the conference call.
Creating a Blind Conference Call

To do a blind conference using the contact card:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 44.)
2. In the second pane, click 📞.
3. In the second pane search field, type the contact name or extension and click Conference.

To do a blind conference using the contextual menu:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 44.)
2. In the quick dialer search bar, type the contact name or number and select the contact.
3. Drag the active call in the notification area and hover over the selected contact for two seconds to view the contextual menu.
4. Select Conference Blind from the contextual menu to initiate the conference.

Creating a Consultative Conference Call

To do a consultative conference call:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 44.)
2. In the second pane, click 📞.
3. In the second pane search field, type the contact name or extension and click Consult.
   The active call is placed on hold automatically, allowing you to consult the third person.
4. Click 📞 to initiate the conference call.

Creating an Intercom Conference Call

You can add a participant to an active call by placing the active user on hold and then using the intercom conference feature to call the third user without ringing the phone line.

To do an intercom conference call:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 44.)
2. In the second pane, click 📞.
3. In the second pane search field, type the contact name or extension and click Intercom.
The active call is placed on hold, and the call to the third user is automatically answered on the phone line.

4. Click icon to initiate a conference call.

Managing Call Notes and Viewing Routing Slips

Call note allows you and the other members on the call to add, view, and edit notes for an incoming call, a call that is on hold, and an active call.

Routing Slips displays the history and call routing details of the call.

*Table 3* describes the various call note and routing slip status for an incoming call, call on hold, and active call.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates that the return routing slip is open. This icon is displayed when the call that you parked is returned to you and when the routing slip is open.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates that the return routing slip is closed. This icon is displayed when the call that you parked is returned to you and when the routing slip is closed.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates that the routing slip is closed. To open, click the icon.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates that the routing slip is open. If there is only one call, by default, the routing slip of the call is open. If there are multiple calls, by default, the routing slip is open only for the oldest call on the dashboard. For the other calls, click the icon to open the routing slip.</td>
</tr>
</tbody>
</table>
To enable routing slips and call notes:

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click Telephony.
4. Select Show access to routing slip and call note for each call in the dashboard.

The call stack displays routing slip and call note icons.

You can click 📄 to view or hide the routing slip and click 📄 to view or hide the call note for a call.

---

**Note**

By default, the routing slip is open for the oldest call on the dashboard. For the other calls, click 📄 to open it.
Making a Video Call

To make a video call, the Primary Extension must be assigned to your Softphone. (For details about how to assign your extension to the softphone, see Assigning Softphone on page 37.)

1. Find and select a contact. (For more information, see Managing Contacts on page 22.)

2. To make a voice call, do one of the following:
   - In the third pane, click 📞.
   - Double-click the contact to make a voice call.

3. To start broadcasting your video to the other party, click 📹.

4. To end the video, click Turn off Video Camera icon.

Setting Up Video Camera Preferences

You can set up the ShoreTel Connect client to use the video camera:

- By default
- Prompt you to turn on the camera
- Wait for you to activate the camera manually, which lets you have complete control of your video camera.

To set up the video camera:

1. On the dashboard, click the <username> tab.
2. For Mac OS, click Preferences. For Windows, click Settings.
3. Click Video > Permissions.
4. Select one of the following video options:
   - Automatically start my camera without asking
   - Ask me if I want to use my camera
   - Never ask me, I'll turn the camera ON myself
5. Click Video > Camera Setup, and select the video device from the drop-down list. (You can view a preview from the selected video device.)
Managing Voicemail

Callers can leave a voicemail message if a call is not answered. The voicemail message is delivered to your assigned desk phone, the ShoreTel Connect client, and your email inbox. This section includes the following topics:

- Forwarding Calls to your Voicemail Inbox on page 55
- Leaving a Voicemail Message on page 55
- Accessing Voicemail Messages on page 56
- Viewing Voicemails from a Contact on page 56
- Listening to a New Voicemail Message on page 56
- Flagging a Voicemail Message on page 56
- Replying to a Voicemail Message on page 57
- Forwarding a Voicemail Message on page 57
- Deleting a Voicemail Message on page 58
- Restoring a Deleted Voicemail Message on page 58
- Configuring Email Notifications for Voicemail Messages on page 58
- Setting Popup Notifications for Voicemail Messages on page 58
- Changing your Voicemail Password on page 59

Note

To alert you about an incoming voicemail message you can set an email notification or a system popup notification. For more information, see the following topics:

- Configuring Email Notifications for Voicemail Messages on page 58
- Setting Popup Notifications for Voicemail Messages on page 58

Forwarding Calls to your Voicemail Inbox

When you receive an incoming call that you don’t want to answer, click in the notification area. The caller is directed to record a voice message.

After a caller leaves a voicemail message, you receive a badge notification on the Voicemail tab on the dashboard and on the ShoreTel Connect client icon on your computer task bar.

Leaving a Voicemail Message

1. Dial a contact. (For more information, see Making a Voice Call on page 43.)
2. When you are prompted to leave a voicemail message, record your message.
Accessing Voicemail Messages

1. On the dashboard, click the **Voicemails** tab.

2. To access the voicemail messages for a specific category:
   - Click the **All** tab to view all voicemail messages. The new voicemail messages are displayed in red.
   - Click the **Flagged** tab to view flagged voicemail messages that you have marked for easy retrieval.

   You can choose to reply, forward, or delete the received voicemails.

3. The Deleted Voicemails tab is displayed only if you have any deleted voicemail messages. To access the deleted voicemails, click  on the **Deleted Voicemails** header. By default, the Deleted Voicemail tab is in collapsed view and displays the number of deleted voicemails on the header.

Viewing Voicemails from a Contact

1. In the **Quick Dialer Search** bar, type the name or extension number and select the contact.

2. In the third pane, click the drop-down list in the **Search** field and select **Voicemails**.

   All voicemails from a selected contact are displayed in the third pane. Click each voicemail entry to reply, forward or delete the voicemail.

Listening to a New Voicemail Message

1. On the dashboard, click the **Voicemails** tab.

2. In the second pane, select the voicemail.

3. Click  to play the message through desk phone or  to play through the computer speaker, and click  .

   You can choose to reply, forward, or delete the received voicemail.

Flagging a Voicemail Message

1. On the dashboard, click the **Voicemails** tab.

2. In the second pane, click the **All** tab.

3. Right-click the voicemail you want to flag, and select **Flag Voicemail**.
Replying to a Voicemail Message

1. Access your voicemail messages as described in Accessing Voicemail Messages on page 56.
2. Click the voicemail that you want to reply to.
3. Click **Reply** and select any of the following icons:
   - to record the message through the telephone.
   - to record the message through the computer microphone.
4. Click **to record your message**.
5. Click **to stop recording**.
6. Click **to play your recorded message**.
7. Edit the **To** and **Subject** fields as required.
8. Specify any desired options (Urgent, Private, Receipt, and Include Original) for sending the response.
9. Click **Send**.

Forwarding a Voicemail Message

1. Access your voicemail messages as described in Accessing Voicemail Messages on page 56.
2. Click the voicemail message that you want to forward.
3. Click **Forward** and select any of the following icons:
   - to record the message through the telephone.
   - to record the message through the computer microphone.
4. Click **to record your message**.
5. Click **to stop recording**.
6. Click **to play your recorded message**.
7. Edit the **To** and **Subject** fields as required.
8. Specify any desired options (Urgent, Private and Receipt) for sending the message.

9. Click Send.

Deleting a Voicemail Message

1. Access your voicemail messages as described in Accessing Voicemail Messages on page 56.

2. Do one of the following:
   - Right-click the voicemail you want to delete, and select Delete.
   - Select the Voicemail you want to delete and click Delete.

Restoring a Deleted Voicemail Message

1. On the dashboard, click the Voicemails tab.

2. Click on the Deleted Voicemails header to view the deleted voicemail messages.

3. Select the voicemail you want to restore.

4. Click Restore.

Configuring Email Notifications for Voicemail Messages

1. On the dashboard, click the <username> tab.

2. For MAC OS, click Preferences.
   
   For Windows, click Settings.

3. Click Notifications > Voicemail.

4. Select the Send email notification about incoming voicemail to option, and type the email address.

5. Do the following to customize the email notification:
   - To receive the voicemail as .wav file format, select the Attach voicemail as a wave file option.
   - To mark the voicemail as heard in your voicemail inbox, select the Mark voicemail as heard option.

Setting Popup Notifications for Voicemail Messages

1. On the dashboard, click the <username> tab.

2. For Mac OS, click Preferences.
For Windows, click **Settings**.

3. Click **Notifications > Popup**.

4. To get a system notification for an incoming voicemail:
   - For Windows, select the **Show a system notification for a voicemail** option.
   - For MAC OS X:
     1. Under **Incoming Voicemail**, click **Configure via OS X Notification Center...**
     2. In the Notification Center box, click the ShoreTel Connect Client icon.
     3. Click any of the following:
        - None
        - Banners
        - Alerts

### Changing your Voicemail Password

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click **Preferences**.
   For Windows, click **Settings**.
3. Click **Voicemail > Setup**.
4. Enter:
   - Current password
   - New password
   - Confirm new password
5. Click **Set New Password**.

### Recording Voicemail Greeting Name

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click **Preferences**.
   For Windows, click **Settings**.
3. Click **Voicemail > Setup**.
4. Click the **Record New Name**.
5. Click 🔴 to start recording your name, and click ⏹️ to stop the recording.
6. Click to listen to the recorded greeting.

7. Do one of the following:
   - To save the recording, click Save Recording.
   - To discard the recorded greeting, click Discard Recording, and repeat steps 4 to 7.

### Playing Envelope Information for Voicemail

1. On the dashboard, click the <username> tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click Voicemail > Playback.
4. Select Play envelope information when listening to messages to hear the received date and time of the voicemail.

   The system will announce the date and time when the voicemail was received in the user's inbox before playing the message.

### Routing Calls

Use the following methods to route incoming calls to your predefined external phones:

- Availability Routing—To assign call routing rules based on availability states
- Power Routing—To set customized rules

### Availability Routing

Availability Routing allows you to route incoming calls according to your availability state.

You can configure Availability Routing with or without Mobility.

### Configure Availability Routing with Mobility

1. On the dashboard, click the <username> tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click Call Routing > Availability Routing.
4. In the When field, click the drop-down list, and select one of the availability states.
5. Click the **Start Wizard** on the right.

6. To specify your ShoreTel Mobility enabled device, do one of the following:
   - In the blank field, type your 10-digit mobile number.
   - If you do not have a mobility device, then click **My device with ShoreTel Mobility will not have a number associated with it**.

7. Click **Next**.

   The Simultaneous Ring page is displayed.

8. To enable an additional device, other than your extension and a mobility device, to ring simultaneously:
   a. Enable the **Also simultaneously ring these numbers** option.
   b. Click the **Select Number** drop-down list.
   c. Select the appropriate option, and click **Use Selected Number**.

9. Click **Next**.

   To configure call forwarding, select one of the following options:

   **Note**

   By default, incoming calls are routed to your extension and to your Mobility device.

   By default, the Simultaneous Ring page displays an extension and a mobility device that are already included for simultaneous ring.

   If you are not available on any of the devices configured for simultaneous ringing, then you can route the incoming calls either to your voicemail or to any other external number with appropriate permissions.

   - Select **Keep ringing the numbers above**.
   - Incoming calls will not be forwarded, and only the devices dedicated for simultaneous ringing are permitted to ring.
   - If you want to forward incoming calls to your voicemail or to another contact, do the following:
     1. Select **Forward the call to**, and click on the drop-down list, and either select *my voicemail* or type in the contact name or the external number, if you have appropriate permissions.
     2. Click the drop-down list to select the number of rings before forwarding.
3. In the **if I have more than 16 active calls forward immediately to** field, click the drop-down list, and either select **my voicemail**, or type the contact name or the external number, if you have appropriate permissions.

- Select the **Always forward my calls to** option, and click the drop-down list, and either select **my voicemail** or type the contact name or the external number, if you have appropriate permissions.

10. Click **Next**.

The Voicemail Greeting: Recording & Playback page is displayed.

11. To record the voicemail greeting:

   a. Click ✌ to start recording your message, and click ■ to stop the recording.

   b. Click ➤ to listen to the recorded greeting for any incoming voicemail messages.

   c. Do one of the following:
      1. To save the recorded greeting, click **Save Recording**.
      2. To discard the recorded greeting, click **Discard Recording**.

12. Click **Next**.

The Interacting with Greeting page is displayed.

13. To enable interaction with the voicemail greeting:

   a. Under **Are callers allowed to leave a voicemail after hearing your greeting?**, select one of the following options:
      - Yes, callers can leave a voicemail.
      - No, callers will not be able to leave a voicemail.

   b. If you want to forward the incoming call to a particular extension, in the **If callers press ‘0’ while listening to your greeting Forward calls to** field, type a contact name or an extension.

14. Click **Done**.

### Configuring Availability Routing without Mobility

1. On the dashboard, click the `<username>` tab.

2. For Mac OS, click **Preferences**.

   For Windows, click **Settings**.

3. Click **Call Routing > Availability Routing**.

4. Click the **Start Wizard**.
The Simultaneous Ring page is displayed.

**Note**
By default, the Simultaneous Ring page displays the device that is already configured for simultaneous ring.

5. To enable simultaneous ring for an additional device, do the following:
   a. Select the *Also simultaneously ring these numbers* option.
   b. Click the *Select Number* drop-down list.
   c. Select the additional number, and click *Use Selected Number*.

6. Click *Next*.

7. To configure call forwarding, select one of the following options:
   - If you do not want to forward incoming calls, select *Keep ringing the number above* so that the devices dedicated for simultaneous ringing are only permitted to ring.
   - If you want to forward incoming calls to your voicemail, do the following:
     1. Select *Forward the call to* and click on the down arrow icon, and select *my voicemail*.
     2. Click the drop-down list to select a number for the rings before forwarding.
     3. In the *if I have more than X active calls forward immediately to* field, click the down arrow icon, and select *my voicemail*.
   - Select the *Always forward my calls to* option, click the drop-down list, and select *my voicemail*.

8. Click *Next*.

9. To enable FindMe, do the following:

**Note**
If the FindMe option is not displayed, contact your Administrator to enable the “Allow external call forwarding and find me destination” option on the Connect Director.

   a. Select *Enabled: Use my FindMe settings to continue routing the call*.
   b. Select any one of the following options:
      - Select *Ring my FindMe numbers sequentially before playing my voicemail*, and optionally select *Prompt the caller to record their name*.
      - Select *Play my voicemail first. If the caller presses 1 during the greeting then sequentially ring my FindMe numbers*, and check *Prompt the caller to record their name*. 
c. To define FindMe numbers that will be used sequentially, click the Select Number drop-down list, select the appropriate option and click Use Selected Number.

d. To add another FindMe number, repeat step 8c.

10. Click Next.

The Voicemail Greeting: Recording & Playback page is displayed.

11. To enable voicemail greeting, see To record the voicemail greeting: on page 62.

12. Click Next.

The Interacting with Greeting page is displayed.

13. To enable interacting with the voicemail greeting, see To enable interaction with the voicemail greeting: on page 62.

Configuring Availability Routing Using Custom Settings

1. On the dashboard, click the <username> tab.

2. For MAC OS, click Preferences.
   For Windows, click Settings.

3. Click Call Routing > Availability Routing.

4. To configure a mobility device for incoming calls, see To specify your ShoreTel Mobility enabled device, do one of the following: on page 61.

5. Click Change to configure the following individual options, as required:

   - Simultaneous ringing
     - For more information about configuring simultaneous ring with mobility enabled, see step 8 in Configure Availability Routing with Mobility on page 60.
     - For more information about configuring simultaneous ring without mobility enabled, see step 5 in Configuring Availability Routing without Mobility on page 62.

   - Incoming call forwarding
     - For more information about incoming call forwarding with mobility enabled, see step 9 in Configure Availability Routing with Mobility on page 60.
     - For more information about incoming call forwarding without mobility enabled, see step 7 in Configuring Availability Routing without Mobility on page 62.

   - Voicemail Greeting: Recording & Playback
     For more information, see To record the voicemail greeting: on page 62.
Using Power Routing

Power Routing allows you to create customized personal rules for call routing. You can also edit and delete your power routing rules.

Power Routing overrides Availability Routing.

Creating a Power Routing Rule

1. On the dashboard, click the <username> tab.
2. For MAC OS, click Preferences.
   For Windows, click Settings.
3. Click Call Routing > Power Routing.
4. Click Create New Power Rule.
5. In the Rule Name field, enter a <name> for the new power rule.
6. In the When field, choose a combination of the following conditions to build a custom file for when to forward a call:
   - + number matches
   - + dialed number
   - + my availability
   - + on the phone
   - + time is
7. To add a rule by matching a number:
   a. Click + number matches.
   b. Click the The number is drop-down list, and select a suitable option. (For a few of these options, you might have to enter an associated number in the corresponding field.)
   c. To create another rule, repeat steps 7a to 7b.
8. To add a rule based on the known dialed number:
   a. Click + dialed number.
   b. Click inside the Number caller dialed to reach me is field, and type in the known number.
9. To add a rule based on your availability:
   a. Click + my availability.
b. Select one of the availability states:
   - Available
   - In a Meeting
   - Out of Office
   - Vacation
   - Custom
   - DND

10. To add a rule if you are already on a phone, click + on the phone.

11. To add a rule based on the time or on the day:
   a. Click + time is.
   b. Select either of the following:
      - If Time is selected, enter the From and To fields for the power rule.
      - If Day is selected, select the days for the power rule.

12. Under Then, click Forward call to and select any of the following options:
   - To forward the call to voicemail, select the my voicemail option.
   - To play a ring tone:
     - Click the my voicemail drop-down list and select play ringtone. An additional Standard Ring option is displayed.
     - Click on the drop-down list and select a ring tone option.
   - To forward the call to specific number, select the Select Number option and click in the Select Number field and type the desired number.

13. Click Create Rule.

**Modifying a Power Routing Rule**

1. On the dashboard, click the <username> tab.

2. For MAC OS, click Preferences.
   - For Windows, click Settings.

3. Click Call Routing > Power Routing.

4. For the power rule you want to edit, click Edit.

5. Edit the steps as required. (For more information, see steps 6 to 12 of Creating a Power Routing Rule on page 65.)

6. Click Save Rule.
Deleting a Power Routing Rule

1. On the dashboard, click the <username> tab.
2. For MAC OS, click Preferences.
   For Windows, click Settings.
3. Click Call Routing > Power Routing.
4. Click Delete for the power rule you want to delete.

Routing Calls to Mobile

You can route all your incoming calls to your Mobility device. You can select or enter the mobile number on which you have installed the ShoreTel Mobility.

To enable this feature, your ShoreTel administrator must configure the Enable Enhanced Mobility with Extension feature in the ShoreTel Connect Director.

Customizing your Call Option Settings

1. On the dashboard, click the <username> tab.
2. For MAC OS, click Preferences.
   For Windows, click Settings.
3. Click Telephony.
4. Click the Maximum number of concurrent calls drop-down list, and select a number in the range configured by your ShoreTel administrator.
5. If you want to suppress call waiting tone, select Suppress call waiting tone when I’m on a call.
6. If you want to suppress dial tone, select Suppress dial tone when I’m off-hook in headset mode on an analog phone.
7. If you want to close contact card, select Close contact card after call ends option to close the contact card soon after you end the call.
CHAPTER 7

Managing Instant Messaging

This chapter provides information about managing instant messaging.

- Sending an Instant Message................................................................. 70
- Viewing IM Conversation History with a Contact ...................... 71
- Scheduling a Meeting with a Contact Group ......................... 71
- Sending a Group Voicemail ................................................................. 72
- Managing Instant Messaging Notifications.......................... 72
- Adding Canned IM Responses............................................................. 73
- Blocking IM Notifications for Specific Users ......................... 73
**Sending an Instant Message**

You can send instant messages to:

- Individuals
- Groups
- Multiple users

*Figure 5* describes the various ways to send instant messages to an individual, groups, and multiple users.

![Diagram of sending IM](Diagram)

*Figure 5: Sending an IM*

To send an instant message to individuals:

1. Find the contact (For more information, see *Managing Contacts* on page 22).
2. In the IM input field, type the message, and press **Enter**.

---

**Managing Instant Messaging**

**Sending an Instant Message**

You can send instant messages to:

- Individuals
- Groups
- Multiple users

*Figure 5* describes the various ways to send instant messages to an individual, groups, and multiple users.

![Diagram of sending IM](Diagram)

*Figure 5: Sending an IM*

To send an instant message to individuals:

1. Find the contact (For more information, see *Managing Contacts* on page 22).
2. In the IM input field, type the message, and press **Enter**.
To send an instant message to groups:

1. Click the People > Groups tabs, and select a group.
   
   You can also send instant messages to an individual member of a group by selecting a particular member from the selected group.

2. Click Start Group Chat.
   
   You can also add more participants to the group after initiating a chat session.

3. Click the Add Participant icon on the IM page to add more participants to the active chat session.

4. In the Quick Dialer Search bar on the third pane, type the participant’s first or last name, extension, company name, phone number, or email address.

5. Select the participant from the search results.

6. Click Add Contact to Conversation.

7. Repeat steps 4 to 6 to add more participants.

To send an instant message to multiple users:

1. Find the contact (For more information, see Managing Contacts on page 22).
   
   You can add more participants only after initiating a chat session.

2. Follow steps 4 to 6 to add more participants to the active chat session.

3. In the IM input field, type the message and press Enter.
   
   You can initiate another chat session with the same participants from the Messages tab. Your chat will appear in the Messages tab after all participants exit from the active chat session. If you want to make a voice call to individuals, groups, or multiple users, click the green call icon.

**Viewing IM Conversation History with a Contact**

1. In the Quick Dialer Search bar, type the contact name or extension number and select the contact.

2. In the third pane, click the drop-down list in the Search field and select Messages.
   
   Your IM conversation history with the contact is displayed in the third pane.

**Scheduling a Meeting with a Contact Group**

1. On the dashboard, click the People tab

2. Click the Groups tab, and select a group.

3. Click Schedule Meeting With Group.
4. Specify the details of the meeting.
5. Click Create Event Invite.

Sending a Group Voicemail

1. On the dashboard, click the People tab.
2. Click the Groups tab, and select a group.
3. Click Send Group Voicemail.
4. Select one of the following options:
   - To record the message through your desk phone’s handset, click the phone icon .
   - To record the message through your computer speaker, click the speaker icon .
5. To start recording the message, click the red circle icon ; to stop recording, click the gray square icon ; to play the recorded message, click the gray arrow icon .
6. Enter the name for your recording in the Subject field.
7. Specify any of the following options for the message:
   - Urgent—recipient can see an exclamation (!) mark next to the voicemail.
   - Private—recipient cannot forward a private voicemail.
   - Receipt—sends an acknowledgment to the sender when the recipient has listened to the voicemail.
8. Click Send.

Managing Instant Messaging Notifications

1. On the dashboard, click the <username> tab.
2. For MAC OS, click Preferences.
   For Windows, click Settings.
3. Click Notifications > Popup.
4. To enable instant messaging notification:
   - On Windows, select Show a system notification for an incoming IM option.
Select **Show IM content in the notification** option to see the IM message in the system notification.

Select **Keep notification on screen for** option, and click the drop-down list and select a number from the list to control the persistence of the IM notification on your system.

On OS X:

1. Click **Configure via OS X Notification Center...** in **Incoming IM**.

2. In the Notification Center box, scroll down to select the **ShoreTel Connect client** icon and then click any of the following options:
   - None
   - Banners
   - Alerts

5. To disable instant messaging notification:

   - On Windows, disable the **Show a system notification for an incoming IM**.

   - On OS X:

     1. Click **Configure via OS X Notification Center...**
     2. Select **Do Not Disturb** on the left notification area.

### Adding Canned IM Responses

You can respond with an IM message to an incoming call from another ShoreTel contact.

To add a canned IM response:

1. On the dashboard, click the `<username>` tab.

2. For MAC OS, click **Preferences**.

   For Windows, click **Settings**.

3. Click **IM > Canned IM Responses**.

4. Type your custom canned message, and click **Add Canned Response**.

5. Select the required canned messages from the text box, and click **Delete** to delete the canned message.

### Blocking IM Notifications for Specific Users

1. On the dashboard, click the `<username>` tab.

2. For MAC OS, click **Preferences**.

   For Windows, click **Settings**.
3. Click IM > Block Notifications.

4. Type the contact name to block the users from sending an IM.
Integrating with Microsoft Exchange

This chapter provides information about integrating the ShoreTel Connect client with Microsoft Exchange:

Integrating the ShoreTel Connect Client with Microsoft Exchange ....................... 76
Synchronizing the Events and the Availability Status with Microsoft Outlook or Office 365 Calendar.................................................................................................................. 77
Synchronizing the Connect Client with Microsoft Outlook or Office 365 Contact Folders.......................................................................................................................... 78
Synchronizing the Connect Client Voicemails with Microsoft Outlook or Office 365 79
Integrating the ShoreTel Connect Client with Microsoft Exchange

You must integrate the ShoreTel Connect client with your Microsoft Exchange to use the following client features:

- Synchronize events and availability status with the Outlook or Office 365 calendar.
- Synchronize your Outlook or Office 365 contact folders with the Connect client for Windows. For Mac OS, the Connect client synchronizes with the Mac Address book. (For more information about synchronizing the Connect client with Mac address book, refer to Importing the Contact Folders on page 25.)
- Send voicemail notifications to Outlook or Office 365.

To integrate Microsoft Exchange with the Connect client:

1. On the dashboard, click the `<username>` tab.
2. For MAC OS, click Preferences. For Windows, click Settings.
3. Click Account > AD Credentials.
   The AD credentials tab does not appear if you have integrated the Connect client with Microsoft Exchange while logging in. For more details about signing in to the Connect client, refer to Signing in to the ShoreTel Connect Client on page 12.
4. In the User name and Password fields, enter your Microsoft Exchange (Active Directory) email address and password respectively.
5. Click Save Credentials.
   If your Exchange server is not configured on the ShoreTel Connect Director, the error message “Your Exchange Server is not set up. Please contact your ShoreTel Administrator” is displayed.
   Upon successful credentials validation, the Unlink ShoreTel Connect from Exchange option is displayed. To disable integration with Microsoft Exchange, click Unlink ShoreTel Connect from Exchange. You must restart the Connect client for the changes to take effect.

Note
If you do not complete the integration with Microsoft Exchange here, the Connect client will prompt you to enter your Microsoft Exchange credentials when you access the Events tab.
Synchronizing the Events and the Availability Status with Microsoft Outlook or Office 365 Calendar

If you have not integrated the Connect client with Microsoft Exchange, you can integrate it from the Events tab.

To integrate the Connect client with Microsoft Exchange from the Events tab:

1. On the dashboard, click the **Events** tab.
2. Enter your Microsoft Exchange credentials in the **User name** and **Password** fields.
3. Click **Submit Exchange Credentials**.

After integrating the Connect client with Microsoft Exchange:

- Your Outlook appointments and Connect client events are displayed on both the Outlook calendar and the Events tab.
- When you create an event on Connect client, a meeting invite with the conference details is displayed in Outlook which can be sent to the participants. For more information about creating an event on Connect client, refer to **Creating a Conference** on page 82.

You can synchronize the availability state between the Connect client and the Outlook or Office 365 calendar. For example, if you have a meeting currently scheduled on Outlook calendar, your availability state on Connect client changes to “In a meeting”.

**Note**
You can also manually change your availability state on the Connect client.

To synchronize your availability state on the Connect client with the Outlook or Office 365 calendar:

1. On the dashboard, click the `<username>` tab.
2. For MAC OS, click **Preferences**, and click **Contacts/Outlook**.
   
   For Windows, click **Settings**, and click **Outlook**.

   **Note**
   For Windows, the “ShoreTelConnectUCBAddIn” add-in should be enabled on your Outlook to complete this synchronization. For more information about enabling Add-ins in Outlook, refer to Microsoft Outlook documentation.

3. Select the **Sync my Exchange calendar with my ShoreTel Connect availability modes** check box.
   
   - Your availability state on the Connect client changes based on your schedule on the Outlook or Office 365 calendar.
   - The Do Not Disturb, the Vacation, and the Custom availability states always take precedence and do not get affected by this setting.
4. Select the **Use my Outlook Work Hours to switch my ShoreTel Connect availability to Out of Office** option to change your availability state to Out of Office based on your work hours and days specified on your Microsoft Outlook or Office 365 calendar.

You must restart the Connect client for the changes to take effect.

For information about setting the work hours and days on Outlook calendar, refer to Microsoft Outlook documentation.

### Synchronizing the Connect Client with Microsoft Outlook or Office 365 Contact Folders

After integrating the Connect client with the Microsoft Exchange, you can import the contact folders from Microsoft Outlook into Connect client to make calls or send instant messages only for Windows.

To import the contact folders from Microsoft Outlook or Office 365 into Connect client (this is applicable only for Windows):

1. On the dashboard, click the `<username>` tab.
2. Click **Settings** and click **Outlook**.
3. Select the **Sync my Outlook contacts** option.
4. Click **+Show contact folders** and select the folders that you want to synchronize with the ShoreTel Connect client.

You can also import the Outlook contact folders shared by other users into your Connect client. For the shared contact folders to appear in **+Show contact folders**, open the shared invitation email and click **Open this Contacts folder**. For more details about sharing a contact folder in Outlook, refer to Microsoft Outlook documentation.

For Mac OS, you can synchronize the Connect client with the Mac address book. For information about synchronizing the Connect client with Mac address book, refer to **Importing the Contact Folders** on page 25.

---

**Note**

The “ShoreTelConnectContactUploadAddIn” add-in should be enabled on your Outlook to import the contact folders. For more information about enabling Add-ins in Outlook, refer to Microsoft Outlook documentation.
Synchronizing the Connect Client Voicemails with Microsoft Outlook or Office 365

After integrating the ShoreTel Connect client with Microsoft Exchange, you can synchronize the Connect client voicemails with Microsoft Outlook or Office 365 only for Windows.

**Note**

The “ShoreTelConnectSTVMAddin” add-in should be enabled on your Outlook to complete this synchronization. For more details about enabling Add-ins in Outlook, refer to Microsoft Outlook documentation.

1. On the dashboard, click the `<username>` tab.
2. Click **Settings**.
3. Click **Voicemail > Outlook**.
4. Select the **Show my voicemails inline in my Outlook inbox** option.
CHAPTER 9

Managing Conferences

This chapter provides information about how to create and manage ShoreTel conferences.

Creating a Conference ........................................................................................................ 82
Creating a Conference from Microsoft Outlook ............................................................. 84
Creating a Reservation-less Conference from My Conference Bridge ......................... 85
Migrating Reservation-less Conferences from ShoreTel Communicator ..................... 86
Viewing Conferences ........................................................................................................ 86
Downloading the iCalendar Data (ICS) File for a Conference ....................................... 87
Joining a Conference ......................................................................................................... 87
Joining a Conference from the Notification Area ......................................................... 88
Joining a Conference from the Events Tab .................................................................... 89
Joining a Conference from Your Calendar .................................................................... 90
Placing a Participant on Mute ......................................................................................... 90
Dropping a Participant from Conference ....................................................................... 91
Recording a Conference ................................................................................................. 91
Canceling a Conference ................................................................................................. 92
Canceling a Conference from the Connect Client ....................................................... 92
Canceling a Conference from Microsoft Outlook ....................................................... 92
Conferencing using ShoreTel Connect Client for Web .................................................. 93
Using the ShoreTel Connect Client for Web ................................................................. 93
Using Group Chat ........................................................................................................... 94
Using Screen Sharing ...................................................................................................... 94
Creating a Conference

1. On the dashboard, click the Events tab.

2. Click +New Event at the bottom of the second pane.

3. In the Name field, enter a name for the conference. This name is used in email notifications about the conference.

4. In the Starts fields, enter the date, and the start time of the conference.

5. In the Meeting Lasts field, enter the duration of the meeting in hours and minutes.

6. From the Occurs drop-down list, select the recurring frequency of the conference.

Note
You see the Occurs field only if you have not integrated the Connect client with Microsoft Exchange on your computer.

7. In the On Site Location field, enter the venue for the conference.

8. In the Meeting type field, select one of the following:
   - Collaborative—Include only the organizers and presenters. You can use this option when you are hosting a conference for a wide list of participants. Everyone is a host and a presenter in this conference type.
   - Presentation—Include all of participants along with the organizers and presenters. You can use this option when you are hosting a conference for a limited number of participants.

9. In the Organizers field, enter the names of the people hosting the conference.

10. In the Presenters field, enter the names of people presenting during the conference.

11. In the Agenda field, enter the name of the agenda and the duration of the agenda in minutes.

12. For a conference with a Presentation meeting type, enter the names of the participants in the Participants field.

13. In the Overview field, enter a brief description of the purpose of the conference.

14. To attach any reference material for the participants, click Choose from Dropbox in the Files section. To attach files, you must sign in to Dropbox with your credentials.

15. To configure settings for your conference, click to expand the + Show Settings drop-down list, and then do the following:
   - To set a password, select the Protect Meeting with Password option, and enter the password in the Password field.

Note
The Participant Code and the Organizer Code are automatically generated.
b. In the **Start the Meeting** section, choose one of the following options:

- When anyone joins
- When one of the organizers joins

c. In the **Participants** section:

- To announce the arrival of a participant on the conference call, select the **Announce when participants arrive** option, and select one of the following options:
  - Play a simple audio tone
  - Prompt participants to record their name, and announce when they try to join and leave the meeting

- To mute all participants joining the conference call, select the **Mute participants on entry** option.

- To display the names of all participants who have joined the conference, select the **Show everyone’s name to all participants** option.

- In the **When dialing out to participants** area, select one of the following options:
  - Must press one to enter audio portion of the meeting
  - Participants are automatically added to the audio portion of the meeting

16. Click **Create Event Invite** to generate the invite.

17. Depending on your configuration, you see one of the following results:

- If the ShoreTel Connect client is successfully integrated with Microsoft Exchange, you see a **Create Conference Success Opening Outlook Please Wait** message. An email invite draft is opened in Microsoft Outlook, where you can review the content, set reminders and recurrence, and review the list of participants before sending the invite. If you do not see this invite, see Chapter 8, **Integrating with Microsoft Exchange** on page 75 for information about integration.

- If you have not integrated the ShoreTel Connect client with Microsoft Exchange, the new event is created and displayed with the ShoreTel assigned details as described in Table 4. When you click **Events** on the dashboard, the conference is listed on the **Upcoming** tab in the second pane.

### Table 4: ShoreTel Conference Details

<table>
<thead>
<tr>
<th>Conference Detail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>The meeting ID that is automatically generated by the ShoreTel system when an event is created</td>
</tr>
<tr>
<td>Local Dial-in number</td>
<td>The conference call dial-in number for host and participants</td>
</tr>
<tr>
<td>&lt;Web Conference link for leader/host&gt;</td>
<td>ShoreTel Conference web page link for the host</td>
</tr>
<tr>
<td>Participant Code</td>
<td>The access code for participants to join the conference call</td>
</tr>
</tbody>
</table>
Creating a Conference from Microsoft Outlook

1. Launch Microsoft Outlook.
2. Click New Items > Meeting.
3. Click the conference icon at the top right corner of the Outlook ribbon.
   
   A ShoreTel conference is automatically generated with the details listed in Table 4 appended to the email invite.
4. In the To field, enter the list of participants to invite to the conference. Click Address Book or Check Names to select or identify directory contacts.
5. To assign participant’s role:
   a. Click Conference > Settings to open the conference settings window.
   b. Un-check Collaborative meeting - everyone can present field.
   c. Click the drop-down next to the participant’s name and select the required role.
   d. Click OK to save.
6. In the Subject field, enter the purpose of the conference.
7. In the Location field, enter the venue of the conference.
8. In the Start time fields, enter the date and start time of the conference.
9. In the End time fields, enter the date and end time of the conference.
10. Click Response Options to configure the responses received from the participants.
11. Select the time slot from the Reminder drop-down list to set a reminder.
12. Click Recurrence if you want the conference to occur more than once.
13. Click the Available Outlook option to configure any other preferences.
14. Click Send.
Creating a Reservation-less Conference from My Conference Bridge

You can use My Conference Bridge to start a conference directly from the ShoreTel Connect client without scheduling the conference in advance. This is called a reservation-less conference. You can also invite other users to join these conferences.

To invite participants to a conference:

1. On the dashboard, click the <username> tab.
2. In the second pane, click the My Conference Bridge tab.
   
   The conference is named as “My Conference”, and you cannot change this name.

3. Host can join the conference by doing any of the following:
   
   a. Click Join My Event Now.
   b. Launch the participant URL provided in My Conference Bridge tab in a web browser.

4. To invite participant to join your conference, do one of the following:
   
   - Click Copy to Clipboard to copy the conference information, and share the information with other users you want to invite.
   - Click Add Participant icon and type the participant’s name that you want to invite and then click Conference.

5. To drop a participant, do one of the following:
   
   - From dashboard:
     1. Click icon below the participant name.
     2. In the confirmation dialog box, click Yes.
   - From My Conference second pane:
     1. Click +Info.
     2. Click on the drop-down next to the participant’s name and select Kick Out of Meeting.
     3. In the confirmation dialog box, click Yes.

Note

- Reservation-less conference details cannot be edited and no date is shown for these conferences.
- Reservation-less conference can be deleted from the ShoreTel Connect Director.
Migrating Reservation-less Conferences from ShoreTel Communicator

Reservation-less conferences migrate from ShoreTel Communicator to the ShoreTel Connect client as follows:

- Users who have a reservation-less conference that was previously configured in ShoreTel Communicator and who are unassigned to a service appliance will get an error message when trying to create a new event or if they try to join to an existing conference in the ShoreTel Connect client. To remove these conferences from the Connect client, users should manually delete the old conferences from Outlook Calendar.

- Users who have a reservation-less conference that was previously configured in ShoreTel Communicator and who are assigned to a service appliance will have a reservation-less conference created during migration, and the settings defined previously remain valid.

While participant codes on a migrated reservation-less conference remain valid, the **When dialing out to participants** parameter in the event screen is always set to **Must press one to enter audio portion of the meeting** regardless of whether the conference was previously configured with **Participants are automatically added to the audio portion of the meeting**.

**Note**

- If users have multiple reservation-less conferences configured in ShoreTel Communicator, all the reservation-less conferences are migrated.

- Reservation-less conferences cannot be edited or changed after migration. Ensure that you have the reservation-less conference(s) configured as required prior to migration.

- Users who do not have a reservation-less conference previously configured in ShoreTel Communicator and who are not assigned to a service appliance will not have a reservation-less conference created during migration.

Accessing Recordings Made with ShoreTel Communicator

Prior to migrating from ShoreTel Communicator to the ShoreTel Connect client, download any recordings made with ShoreTel Communicator and save them to your local system. While the downloaded recordings cannot be played in the ShoreTel Connect client, you can use a Flash player to play them.

Viewing Conferences

1. On the dashboard, click the **Events** tab.
2. Click the **Upcoming** tab to view the list of future conferences.
   
   The list is sorted by date, from the current event to the future events.

3. Click the **Past** tab to view the list of conferences in the past.
The list is sorted by date, from the most recent to the oldest.

**Note**
If you have integrated the ShoreTel Connect client with Microsoft Exchange, you see all your conferences in your Outlook calendar.

---

### Downloading the iCalendar Data (ICS) File for a Conference

The ShoreTel Connect client generates an ICS file for every event if Microsoft Exchange is not deployed. All participants can use this ICS file to populate their calendars with the meeting invite.

To download the Conference iCalendar data file:

1. On the dashboard, click the **Events** tab.
2. Click the **Upcoming** tab to view all upcoming conferences.
3. Select the conference in the second pane to download the ICS file.
4. Click **Download ICS file for External Calendar**.

   The **File Save As** dialog box is displayed. The default file name is `shoretel.ics`, and the default path for saving the file is `C:\Users\<user>\AppData\Local\ShoreTel\Meetings`.

5. Enter the file name and select the location or accept the default, and click **Save**.
6. Locate the file on your computer, and double-click to open the iCalendar file.
7. Review all the information about the conference, and save to your calendar.

---

### Joining a Conference

You can join a conference from the ShoreTel Connect client in the following ways:

- **Joining a Conference from the Notification Area**: Use this procedure if you see a notification for the upcoming conference in the notification area on the dashboard. The notification is usually sent 5 minutes prior to a conference.

- **Joining a Conference from the Events Tab**: Use this procedure to join the conference from the Events tab.

- **Joining a Conference from Your Calendar**: Use this procedure to join the conference from your calendar.
Figure 6 describes the different ways to join a conference.

Joining a Conference from the Notification Area

When you see an event notification on the dashboard, do one of the following to join:

- To configure a call back:
  a. Click the drop-down icon beside the event name.
  b. In the **Call me at** field, enter your phone number.
  c. Click **Call Me**.

- To dial into the conference, click ✆ .

- If you have assigned a softphone to the Connect client, you see a notification on the dashboard when you are connected.

- If you have assigned a desk phone or an external number to the Connect client, the assigned phone rings.
If you are unable to dial into the conference through the assigned phone, see Chapter 5, Managing Phones on page 35.

- To join the conference in chat mode, click 📩. You can also configure a call back and dial into the conference from the chat mode.

To end the conference, click 📞.

### Joining a Conference from the Events Tab

1. On the dashboard, click the **Events** tab.
2. To view all upcoming conferences, click the **Upcoming** tab.
3. Select the conference that you want to join and do one of the following:
   - To configure a call back:
     1. Click the drop-down icon beside the event name.
     2. Enter the number in the **Call me at** field.
     3. Click **Call Me**.
   - To dial into the conference, click 📞.
     - If you have assigned a softphone to the Connect client, you see a notification on the dashboard when you are connected.
     - If you have assigned a desk phone or an external number to the Connect client, the assigned phone rings.
     If you are unable to dial into the conference through the assigned phone, see Chapter 5, Managing Phones on page 35.
   - To join the conference in chat mode, click 📩. You can also configure a call back and dial into the conference from the chat mode.

To end the conference, click 📞.
Joining a Conference from Your Calendar

If you have successfully integrated the ShoreTel Connect client with Microsoft Exchange or have downloaded and added the iCalendar data file to your personal calendar, you can join a conference by opening the appointment on your calendar.

1. Launch your calendar.
2. Open the conference appointment.
   The appointment contains details of the conference, as described in Table 4 on page 83.
3. Click the Click Here to Join link.
4. Enter your name in the Introduce yourself as field, and click Enter.
5. Do any of the following to dial into the conference:
   - To take the call through the softphone (your computer and headset), click Call via Computer Audio.
   - To configure a call back, click the Call Me option, enter the number, and click Call Me.
   - Click in the second pane. If you have assigned a desk phone or a cell phone in the ShoreTel Connect client, the assigned phone rings. If nothing happens, see Chapter 5, Managing Phones on page 35.
6. To end the audio conference, click .

Placing a Participant on Mute

If you are an organizer or a presenter, you can mute and unmute a conference participant individually from the dashboard.

- To mute a participant, click icon below the participant name.
- To unmute a participant, click icon below the participant name.
Dropping a Participant from Conference

Organizer can drop a participant from the conference. To drop a participant:

1. On the dashboard, click icon below the participant name.
2. In the confirmation dialog box, click Yes.

Recording a Conference

1. Dial in to join a conference.
2. Click the conference notification.
3. Click to start recording the conference.

   The REC icon turns red to indicate that recording is in progress.
4. When you want to stop recording, click again.

   You can stop a recording while a conference is in progress. To leave the conference, you must click the red call end icon as explained in Joining a Conference on page 87.

You can access the recording, and then either download or play the recordings.

To access the recording:
1. On the dashboard, click the Events tab.
2. Click the Past tab.

   A list of conferences appears and indicates that it is a recording.
3. Select the recording.

Note

You can play the conference recordings on the Connect client and all web browsers except the Microsoft Internet Explorer 11.
Canceling a Conference

You can cancel a ShoreTel conference any time through either the Connect client or Microsoft Outlook.

Canceling a Conference from the Connect Client

1. Click the Events tab on the dashboard.
2. Click the Upcoming tab to view the list of future conferences.
   The list is sorted by date, from the current event to future events.
3. Click the conference that you want to cancel.
4. Click Cancel Meeting at the bottom of the third pane.
5. Click Cancel Meeting in the confirmation dialog box.
   The Canceling Conference message is displayed at the bottom of the third pane. This message is followed by Opening Outlook Please Wait message, and the Outlook invite is launched (if you have integrated with Microsoft Exchange).
6. Click Send Cancellation in the Outlook invite cancellation window to notify participants of the cancellation.

Canceling a Conference from Microsoft Outlook

If you have integrated the ShoreTel Connect client with Microsoft Outlook, you can cancel a conference from the Outlook client.

1. Launch Microsoft Outlook.
2. Open the conference appointment in the Outlook calendar.
3. Click Cancel Meeting at the top left corner of the Outlook ribbon.
4. Click Send Cancellation to notify participants of the cancellation.
Conferencing using ShoreTel Connect Client for Web

You can use the ShoreTel Connect client for Web to launch ShoreTel conferencing without the ShoreTel Connect client. This feature is useful for remote users who have not installed the client on their systems.

By using the Connect client for Web, you can join a ShoreTel conference from any non-ShoreTel network without entering any authentication details. Organizers joining the conference through the ShoreTel Connect client for Web can only serve as participants, not presenters or organizers in the meeting.

Using the ShoreTel Connect Client for Web

1. Launch the participant URL (provided in the meeting invite sent by the conference host) in a web browser.

2. In the Introduce yourself as box at the bottom of the navigation pane, enter your name. You must introduce yourself to view the conference sharing.

   The navigation pane on the left displays:
   - **Meeting Title**—the conference name
   - **Now Sharing**—the contact currently sharing the screen
   - **Now Speaking**—the contact currently speaking on the conference
   - **Group Chat**—public chat window for all conference participants
   - **Attendees**—list of participants on the conference

3. Dial into the conference using one of the following methods:
   - To take the call through the softphone (your computer and headset), click **Call via Computer Audio**.
   - On the task bar at the bottom of the page, enter your number, and click **Call Me** to receive a call back to the specified number. On answering the call, you are automatically connected to the conference's interactive voice response. You might be prompted to press 1, depending on the meeting settings.
   - Dial the number and enter the code provided in the conference invitation.
   - Click on **More Info** to see the meeting details, and click **Copy** to copy the information.

4. You can perform actions during the conference by clicking any of the following icons on the task bar at the bottom of the page:
   - To leave the call during the conference, click .
   - To mute and unmute your audio during the call, click .
To share your screen, a portion of the screen, or an application window, click 🎨. To copy the meeting information and send it to another person to join the conference, click 🗂️. To ask a question during the conference, click 🗣️.

5. After the conference has ended, close the browser tab to leave the conference.

Using Group Chat

Instant messages from other users are indicated with a red pop-up. Click the group chat window or a participant’s name to view the message.

To send an instant message to the conference participants:

1. Click the Group Chat icon on the left navigation pane.
2. Enter your message in the IM input field at the bottom of the IM chat window, and click Enter.

You will receive IM message notifications with a red pop-out. Click the group chat window or participant’s name to view the message.

Using Screen Sharing

You can use the screen sharing feature to present material to conference participants. You can share the entire screen, a portion of the screen, or an application window.

**Note**

If the share icon is grayed out, your configuration might not support screen sharing. Contact your ShoreTel administrator for more information.
Figure 7 describes the various ways to share the screen.

**Sharing the Entire Screen**

You can share your entire computer screen with the participants allowing them to view the entire computer screen and all your actions on the computer, until you pause or stop sharing.

When full screen sharing is enabled, the edges of the screen are outlined by a red border. This indicates that the portion inside the red rectangular area is being shared. By default, sharing is paused until you manually start sharing.

1. Click on the conference task bar.
2. Click **Share Full Screen**.
3. If you are a first-time user, when you are prompted to install the presenter software, select the appropriate option.
After the software or plugin is installed, screen sharing is enabled.

**Note**

When you attempt to share the screen in the Microsoft Edge browser for the first-time, the ShoreTel Connect client for Web displays multiple pop-ups to install the ShoreTel Presenter.

4. A screen sharing invite is sent to your host on the Connect client before you start sharing your screen.

5. The host must either select the green accept icon to accept viewing your screen or the red close icon to reject your screen sharing invite.

6. Click 🎥 at the top of the page to start sharing.

7. Click ✗ at the top of the page to stop sharing.

### Sharing a Portion of the Screen

If you do not want the participants to view your entire screen, you can choose to share only a portion of your screen that you can highlight and move around as required.

When rectangular area sharing is enabled, a red rectangular window is displayed, which indicates that the portion inside the red rectangular area is being shared. By default, sharing is paused until you manually start sharing.

1. Click ⬅️ on the conference task bar.

2. Click **Share Area**.

3. If you are a first-time user, when you are prompted to install the presenter software, select the appropriate option.

   After the software or plugin is installed, screen sharing is enabled.

**Note**

When the users attempts to share the screen in the Microsoft Edge browser for the first-time, the ShoreTel Connect client for Web displays multiple pop-ups to install the ShoreTel Presenter.

4. A screen sharing invite is sent to your host on the Connect client before you start sharing your screen.

5. The host must either select the green accept icon to accept viewing your screen or the red close icon to reject your screen sharing invite.

6. Click 🎥 at the top of the rectangular area to start sharing.
7. Click ✗ at the top of the rectangular area to stop sharing.

**Sharing an Application Window**

If you want to share only a particular application with the participants and keep everything else private, you can use the application window sharing option.

The selected application is enabled for sharing and is marked by a red border to indicate the area that is being shared. By default, sharing is paused until you manually start sharing.

1. Click ✗ on the conference task bar.

2. Click **Share Window**.

3. If you are a first-time user, when you are prompted to install the presenter software, select the appropriate option.

After the software or plugin is installed, screen sharing is enabled.

---

**Note**

When the user attempts to share the screen in the Microsoft Edge browser for the first time, the ShoreTel Connect client for Web displays multiple pop-ups to install the ShoreTel Presenter.

4. A screen sharing invite is sent to your host on the Connect client before you start sharing your screen.

5. The host must either select the green accept icon to accept viewing your screen or the red close icon to reject your screen sharing invite.

6. In the application selection window, select the application you want to share with the participants.

7. Click ✗ at the top of the application window to start sharing.

8. Click ✗ at the top of the application window to stop sharing.
CHAPTER 10

Sharing on the ShoreTel Connect Client

This chapter provides information about sharing screens and files.

Sharing Screens with a Contact........................................................................................................... 100
Sharing Screens with a Contact

The ShoreTel Connect client enables easy sharing of screens with a contact.

1. Click the People tab or enter the contact name/number in the Quick Dialer Search bar on the dashboard.

2. Click the contact in the second pane.

3. Click the three-point icon in the third pane to share your screen.

4. Do one of the following:
   - Click Share Full Screen to share your entire computer screen with your contact. The information displayed on your screen is visible to your contact.
   - Click Share Area to share a movable rectangular area that you can use to share specific portions of your screen.
   - Click Share Window to share any of the client application windows you have open on your computer. For example, you can choose to share only the Microsoft Outlook Email application window with your contact.

   A screen sharing invite is sent to your contact as a notification. During this time, your computer screen is paused for sharing and is marked by a green rectangular border marking the area to be shared.

5. The contact must either click the green accept icon to accept viewing your screen, or the red close icon to reject the sharing invite.

6. After your contact accepts your sharing invite, click the play icon at the top of the screen to start sharing.

7. To call or have a conference with your contact, click the green call icon in the third pane (For information about using this feature, see Joining a Conference on page 87).

8. To end the screen sharing session, click the close icon at the top of the screen.

   A notification is displayed in your contact’s third pane that indicates that you are no longer sharing your screen.

Note

If you want to call your contact, prior to sharing your screen, see step 7.
Managing Workgroups

This chapter provides information about managing workgroups using the ShoreTel Connect client.

- Workgroups Overview .................................................. 102
- Workgroups Access Types ........................................... 102
- Identify Call by Workgroup Name ................................. 103
- Managing Workgroups .................................................. 103
- Viewing Workgroups Information ................................. 103
- Assigning Call Handling Mode Status ............................ 104
- Filtering Queued Calls .................................................. 104
- Managing Agents ......................................................... 104
- Accessing Workgroups Voicemails ............................... 106
- Configuring Workgroup Notifications ........................... 106
- Setting Queue Monitor Alert Threshold ........................ 106
Workgroups Overview

Note
Workgroup feature is available only for ONSITE users.

Agents and supervisors can see the Workgroups tab on the ShoreTel Connect client dashboard if they belong to any workgroup. The Workgroups tab displays the active workgroup calls for a user, and the current workgroup state.

Table 5. lists the workgroups states of agents and supervisors.

<table>
<thead>
<tr>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Logged In</td>
<td>Logged into the workgroups</td>
</tr>
<tr>
<td>Grey</td>
<td>Logged Out</td>
<td>Logged out of the workgroups</td>
</tr>
<tr>
<td>Yellow</td>
<td>Wrap Up</td>
<td>Agent or Supervisor is performing wrap-up work for a workgroup call.</td>
</tr>
</tbody>
</table>

Workgroups Access Types

You must be a member of a workgroup and have necessary license type to view information about workgroups. Your license type determines what type of member you are.

Types of workgroup members are:

- **Agent**: These users have the Workgroup Agent license type and access to workgroup information, but not agent information.

- **Supervisor**: These users have the Workgroup Supervisor or Operator license type and access to all workgroup and agent information. They must also be members of a workgroup.

Identify Call by Workgroup Name

When a supervisor or an agent receives a call for a workgroup, the call notification on the dashboard displays the name of the workgroup. This helps users who are members of multiple workgroups to identify which workgroup is receiving a call.
Managing Workgroups

Viewing Workgroups Information

Click the Workgroups tab on the dashboard to view the following workgroup information in the second pane:

- Call Handling Mode icon—Shows the Call Handling Mode status
- Workgroup name—Name of the workgroup
- Queued Calls—Number of calls queued for the workgroup
- Longest Queued—Call that has been on hold for the longest period in the queue
- Longest Call—Call that has the longest call duration

To see the workgroup details, select a workgroup, and click Show Workgroup Details. For all the workgroups selected in the second pane, supervisor can view queued calls, agents and voicemail messages in the third pane. You can also select the workgroups by clicking Settings option at the bottom of the second pane.

Assigning Call Handling Mode Status

A supervisor can assign the Call Handling Mode status to the workgroup.

To assign the Call Handling Mode status:

1. On the dashboard, click the Workgroups tab.
2. In the second pane, click the Call Handling Mode icon beside the Workgroup name and select one of the following:
   - On-Hours
   - Off-Hours
   - Holiday
   - Custom

The Workgroup Call Handling Mode status can be customized using the Custom mode. The Custom mode can be configured only from the ShoreTel Connect Director.

Filtering Queued Calls

Select Queues tab in the third pane for queued calls details. When you filter the workgroup information by queued calls, you can see name of the caller or telephone number. If caller name is not associated with the call, the following information is displayed:

- Duration that the queued call has been in the workgroup
- Duration of the call in the system
Managing Agents

You can see the number of agents logged into the workgroup and manage them using the Agents tab in the third pane. Agents tab is visible to supervisors only. Supervisors can perform all the actions in the Agents tab without logging into Workgroups.

Supervisor can search for an agent in the workgroup agents list from the Agents tab. To search for an agent, type the agent name or extension number in the Search field of the Agents tab.

To change the status of all agents, select Agents tab in the third pane, click Set All Agents from the drop-down list and select any of the following:

- Logged-In
- Logged-Out
- Wrap-Up
- End Wrap-Up

In the agent row, the delegated supervisor can change the agent's availability state by clicking the availability state option.

Supervisors can control the following actions for a single agent without logging into Workgroups:

- Call an agent
- Check voicemail
- Log in an agent
- Log off an agent
- Put the agent in Wrap Up state
- Change the Availability state of an agent

With the proper permissions configured by the ShoreTel administrator, supervisors can also perform the following actions on agents:

- Pick up a call
- Unpark call
- Intercom

Note
To pick calls from the queued calls list, agents and supervisors must select Allow agents to pickup from queue option in ShoreTel Connect Director.
- Whisper page the agent
- Silent coach the agent
- Barge in on the agent
- Silent monitor the agent
- Setting a Sound Notification
- Enable picking up calls and parking calls

## Accessing Workgroups Voicemails

Supervisors and agents can view and listen to the workgroup voicemails without logging into the workgroup.

1. On the dashboard, click the **Workgroups** tab.

2. In the second pane, click **Show Workgroup Details**.

3. In the third pane, click the **Voicemails** tab to view workgroup voicemails.

   All the new voicemails are displayed in red.

4. Select a voicemail and click ![phone](phone.png) to play the voicemail through desk phone or ![computer](computer.png) to play through the computer speaker, and click ![play](play.png).

By default, the Voicemail tab displays the voicemails of all the workgroups you belong to. You can filter the voicemails list to view voicemails by workgroup.

To view voicemails by workgroup, click the drop-down list on the **Voicemail** tab in the third pane and select the workgroup.

---

**Note**

After you exit and reopen the workgroup, the drop-down selection changes to the default value, “All”.

The Deleted Voicemails tab is displayed only if there are any deleted voicemails. By default, this tab is in collapsed view. Click ![delete](delete.png) on the **Deleted Voicemails** header to view the deleted voicemails.

To restore a deleted voicemail of the workgroup, locate the voicemail in the Deleted Voicemails list of the workgroup and click **Restore**.
Configuring Workgroup Notifications

To configure the workgroup notifications:

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click Workgroups.
4. Check Show me notifications when calls arrive in queue to view the notifications for the queued calls.
   Enter the time duration in Keep the notification on screen for field to set the time for displaying the notifications on the screen.
5. Check Continue to show notification while logged out of workgroups to view the workgroup notifications after you log out.

Setting Queue Monitor Alert Threshold

To specify the queue monitor alert thresholds and call arrive in queue notification, click Settings at the bottom of the second pane. You can also access Workgroup settings by:

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click Workgroups.

Supervisor can view all workgroups configured and edit Alert Thresholds for each workgroup. However, agents can view only Alert Thresholds. Closing the preferences window or switching to another tab saves your threshold settings.

When the specified workgroup queue thresholds are exceeded, the queued calls number and/or call duration label color changes to red in the second pane. After the parameter drops below the threshold, the label color changes back to default gray. When the queue threshold exceeds the specified time and number, a sound is played. You can turn the sound on or off using the Bell icon at the bottom of the second pane.

To configure Queue Monitor Alert Threshold:

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click **Workgroups**.

4. Select the **Enable Workgroup** option for the required workgroup to configure queue monitor alert threshold.

5. In the **Turn ON Threshold Alert** field, select the required workgroup to enable the threshold alert.

6. In the **Alert When Queue Reaches or Exceeds** field, increase or decrease the call queue number for the required workgroup.

   This number determines the number of calls that can be queued before sending an alert to the user.

7. If required, in the **Alert When Queued Time Exceeds** field, enter the time duration to set the queue monitor alert threshold for the workgroup.
Operator Features

This chapter provides information on how to enable, and access operator specific features.

Operator Features

411
Operator Features

ShoreTel Operator license provides the operators with additional features and functionalities within the ShoreTel Connect client that makes easier to manage large volume of calls within the application.

You must have operator license to access operator features and functionalities. Refer *ShoreTel Connect System Administration Guide* to enable operator license for ONSITE and *Support site* for CLOUD.

ShoreTel Connect client provides special features for operators as listed in the Table 6:

<table>
<thead>
<tr>
<th>Features</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag and drop</td>
<td>Operators can left-click and drag an object in both the directions; from call stack to a contact and vice versa.</td>
</tr>
<tr>
<td>Drag and hover</td>
<td>Operators can left-click and hover an object in both the directions; from call stack to a contact and vice versa to access more telephony functions. The advanced telephony functions are:</td>
</tr>
<tr>
<td></td>
<td>■ Blind Transfer</td>
</tr>
<tr>
<td></td>
<td>■ Consultative Transfer</td>
</tr>
<tr>
<td></td>
<td>■ Intercom Transfer</td>
</tr>
<tr>
<td></td>
<td>■ Transfer to Mailbox</td>
</tr>
<tr>
<td></td>
<td>■ Park</td>
</tr>
<tr>
<td></td>
<td>■ Park and Page</td>
</tr>
<tr>
<td></td>
<td>■ Park and Intercom</td>
</tr>
<tr>
<td></td>
<td>■ Blind Conference</td>
</tr>
<tr>
<td></td>
<td>■ Consultative Conference</td>
</tr>
<tr>
<td></td>
<td>■ Intercom Conference</td>
</tr>
<tr>
<td></td>
<td>For more information, refer to <em>Transferring a Call</em> on page 45.</td>
</tr>
<tr>
<td>Call stack orientation</td>
<td>Operators can view the oldest call at the top of the call stack and the most recent call at the bottom.</td>
</tr>
<tr>
<td>Double click to answer</td>
<td>To answer an incoming call, operators can:</td>
</tr>
<tr>
<td></td>
<td>■ Double-click anywhere in the incoming call notification area.</td>
</tr>
<tr>
<td></td>
<td>■ Click the green call icon as other users.</td>
</tr>
</tbody>
</table>
Routing slip

Operators can view or hide the routing slip for each call by toggling the routing slip icon in the incoming call notification area.

**Note:** Routing slip is disabled by default.

To enable routing slip, refer to Managing Call Notes and Viewing Routing Slips on page 52.

Changing availability state of a contact

Operators can change a contact’s availability state if:
- Contact belongs to the contact group created by operator.
- Contact has added operator on his access list. To add a contact to access list, refer Allowing a Contact to Manage your Availability State on page 32.

To change a contact’s availability state, do one of the following:
- Right-click a contact, and select Change Availability <availability state>.
- Open the contact card by selecting a contact, click on the arrow next to contact’s availability state, and select the state.

Identifying the call by workgroup name

When an operator receives a call for a workgroup, the call notification on the dashboard displays the name of the workgroup. This helps users who are members of multiple workgroups to identify which workgroup is receiving a call.